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KHỞI	ĐỘNG

CÀI	ĐẶT
Windows
Cài	đặt
Khởi	động	MuseScore
Gỡ	bỏ	MuseScore

Mac	OS	X
Cài	đặt
Gỡ	bỏ

Linux
Fedora

Tham	khảo	thêm

TẠO	BẢN	NHẠC	MỚI
Trung	tâm	khởi	tạo
Tạo	bản	nhạc	mới
Tên	bài	nhạc,	nhạc	sĩ	và	thông	tin	khác
Các	nhạc	cụ	và	các	bè
Thêm	khuông	nhạc	nối	kết	cho	một	nhạc	cụ
Chọn	hóa	biểu	và	nhịp	độ
Số	chỉ	nhịp,	ô	nhịp	lấy	đà	(anacrusis),	và	số	lượng	ô	nhịp
Điều	chỉnh	bản	nhạc	sau	khi	tạo
Các	kiểu	mẫu
Tham	khảo	thêm
Những	liên	kết	khác

THIẾT	LẬP	NGÔN	NGỮ	VÀ	CẬP	NHẬT	BẢN	DỊCH
Thay	đổi	ngôn	ngữ
Cập	nhật	bản	dịch
Xem	thêm

KIỂM	TRA	CẬP	NHẬT
Kiểm	tra	cập	nhật	tự	động
Kiểm	tra	cập	nhật
Xem	thêm

CÁC	THAO	TÁC	CƠ	BẢN

NHẬP	NỐT	NHẠC
Cách	nhập	nốt	cơ	bản
Bước	1:	Điểm	khởi	đầu
Bước	2:	Chế	độ	'Nhập	nốt'
Bước	3:	Về	trường	độ	của	nốt	nhạc	(hay	dấu	lặng)
Bước	4:	Nhập	cao	độ
Các	phím	tắt	khác

Bàn	phím	MIDI
Tô	màu	các	nốt	nhạc	nằm	ngoài	phạm	vi	của	nhạc	cụ
Làm	nhỏ	nốt	nhạc
Thuộc	tính	của	nốt	nhạc
Thay	đổi	nốt	nhạc	(mà	không	đổi	tiết	tấu)
Xem	thêm
Các	liên	kết	khác

CAO	ĐỘ	THEO	ÂM
Xem	thêm

SAO	CHÉP	VÀ	DÁN
Sao	chép
Dán
Nhân	bản	nhanh
Bộ	lọc	cho	vùng	được	chọn
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Xem	thêm
Những	liên	kết	khác

CHẾ	ĐỘ	ĐIỀU	CHỈNH
Xem	thêm

CÁC	THAO	TÁC	TRÊN	Ô	NHỊP
Nối	thêm
Chèn	thêm
Xóa	bỏ
Các	đặc	tính
Khuông	nhạc
Trường	độ	của	ô	nhịp
Những	thuộc	tính	khác

Việc	đánh	số
Tách	và	ghép
Xem	thêm

BẢNG	CÔNG	CỤ
Thêm	các	ký	hiệu	vào	bản	nhạc
Các	bảng	công	cụ	Cơ	bản	và	Chi	tiết
Các	ký	hiệu	âm	nhạc	khác
Điều	chỉnh	một	bảng	công	cụ
Xem	thêm

THIẾT	LẬP
Thẻ	"Tổng	quát"
Thẻ	"Bộ	vẽ"
Thẻ	"Nhập	nốt"
Thẻ	"Bản	nhạc"
Thẻ	"Nhập/Xuất	âm	thanh"
Thẻ	"Nhập	dữ	liệu"
Thẻ	"Xuất	dữ	liệu"
Thẻ	"Phím	tắt"
Thẻ	"Cập	nhật"
Xem	thêm

LƯU	TRỮ/XUẤT	DỮ	LIỆU/IN	ẤN
Trình	đơn	"Tập	tin"
Các	định	dạng	trong	trình	đơn	'Lưu	trữ',	'Lưu	trữ	với...',	'Lưu	một	bản	sao...',	'Lưu	phần	đang	chọn...'	và	'Lưu	trực	tuyến...'
Các	định	dạng	trong	trình	đơn	'Xuất	bản	nhạc'	(và	'Xuất	các	bè	nhạc...')
Trình	đơn	"In	ấn"

Xem	thêm

CÁC	CHẾ	ĐỘ	CHỌN
Chỉ	chọn	một	đối	tượng
Chọn	một	dãy
Chọn	nhiều	đối	tượng	không	liền	nhau
Chọn	tất	cả	đối	tượng	tương	tự
Chúng	dùng	cho	mục	đích	gì
Xem	thêm

HOÀN-TÁC	VÀ	LÀM-LẠI

CÁC	CHẾ	ĐỘ	XEM
Chế	độ	Xem-theo-trang/Xem-liền-dòng
Chế	độ	Xem-theo-trang
Chế	độ	Xem-liền-dòng

Thu	phóng
Cách	hiển	thị	khác	của	bản	nhạc
Chế	độ	Toàn-màn-hình
Bộ	điều	hướng
Xem	thêm
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ĐỊNH	DẠNG	TẬP	TIN
Định	dạng	riêng	của	MuseScore
Định	dạng	MuseScore	(*.mscz)
Định	dạng	không	nén	Uncompressed	MuseScore	(*.mscx)

Các	tập	tin	dự	phòng	MuseScore
Tập	tin	dự	phòng	MuseScore	(*.mscz,	hoặc	*.mscx,)

Xem	và	in	ấn	(dùng	cho	xuất	dữ	liệu)
PDF	(*.pdf)
PNG	(*.png)
SVG	(*.svg)

Tập	tin	để	nghe	(dùng	cho	xuất	dữ	liệu)
WAV	audio	(*.wav)
FLAC	audio	(*.flac)
Ogg	Vorbis	(*.ogg)
MP3	(*.mp3)

Chia	sẻ	với	phần	mềm	âm	nhạc	khác
MusicXML	(*.xml)
Compressed	MusicXML	(*.mxl)
MIDI	(*.mid,	*.midi,	*.kar)
MuseData	(*.md)	(dùng	cho	nhập	dữ	liệu)
Capella	(*.cap,	*.capx)	(dùng	cho	nhập	dữ	liệu)
Bagpipe	Music	Writer	(*.bww)	(dùng	cho	nhập	dữ	liệu)
BB	(*.mgu,	*.sgu)	(dùng	cho	nhập	dữ	liệu)
Overture	(*.ove)	(dùng	cho	nhập	dữ	liệu)
Guitar	Pro	(*.GTP,	*.GP3,	*.GP4,	*.GP5,	*.GPX)	(dùng	cho	nhập	dữ	liệu)

Xem	thêm

CHIA	SẺ	BẢN	NHẠC	TRỰC	TUYẾN
Tạo	tài	khoản
Chia	sẻ	bản	nhạc	trực	tiếp	từ	phần	mềm	MuseScore
Tải	bản	nhạc	lên	trang	MuseScore.com
Điều	chỉnh	bản	nhạc	trên	trang	MuseScore.com
Xem	thêm

KÝ	ÂM

DẤU	HÓA	BẤT	THƯỜNG
Xác	định	lại	cao	độ
Xem	thêm
Liên	kết	bên	ngoài

DẤU	RẢI	GAM	VÀ	VUỐT	PHÍM
External	links

VẠCH	NHỊP
Change	bar	line	type
Create	grand	staff	(great	stave)
See	also

DẤU	NỐI-CỜ-NỐT
See	also

NGOẶC	NỐI	KHUÔNG
Delete
Add
Change
Edit
Horizontal	offset

DẤU	LẤY/NGẮT	HƠI

KHÓA	NHẠC
Add
Remove

KÝ	ÂM	CHO	TRỐNG
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MIDI	Keyboard
Computer	Keyboard
Mouse
Drumset
External	links

NỐT	LÁY
Instructions
External	links

DẤU	BIẾN	CƯỜNG

HÓA	BIỂU
Replace	an	existing	key	signature
Add	a	new	key	signature
Remove	a	key	signature
Courtesy	key	signature
Naturals	on	key	signature	changes
Key	signature	and	multimeasure	rest
Courtesy	key	signature	and	section	break
Custom	key	signatures

ĐƯỜNG	KẺ	HAY	NÉT	VẼ
Change	length
See	also

DẤU	LẶNG	TRONG	Ô	NHỊP
Full	measure	rest
Multi-measure	rest
Instructions
Limitations

Break	multimeasure	rest

DẤU	LẶP
Playback
Repeat	symbols	and	text
Jumps
See	also
External	links

DẤU	LUYẾN
First	Method
Second	Method
Third	Method
Adjustments
Dotted	line
See	also

DẤU	NỐI
First	method
Second	method
Tied	chords

SỐ	CHỈ	NHỊP
Create	your	own	Time	Signature
Change	default	beaming
Delete	a	time	signature
Edit	to	additive	meters
Different	duration	from	time	signature:	Pickup	measures	(Anacrusis)	and	Cadenzas
Local	Time	Signatures
Time	signature	changes	and	Other	Objects
See	also
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81

SỰ	CHUYỂN	TÔNG	HAY	GIỌNG
Chromatic	transposition,	by	key
Chromatic	transposition,	by	interval
Diatonic	transposition
Transposing	instruments
See	also

TIẾNG	VÊ

DẤU	LIÊN
Instructions
Note	input	mode
Properties
Style
See	also
External	links

CÁC	GIỌNG
When	to	use	voices
Instructions
Hidden	spacer	rests
Exchange	voices	of	notes
See	also
External	links

DẤU	VOLTA
Text
Playback
External	links

VẤN	ĐỀ	ÂM	THANH	VÀ	PHÁT	BẢN	NHẠC

CHỮ	VIẾT

ĐỊNH	DẠNG

CÁC	CHỦ	ĐỀ	NÂNG	CAO

CÁC	CHỨC	NĂNG	MỚI	TRONG	MUSESCORE	2.0

SEE	ALSO

HỖ	TRỢ

PHỤ	LỤC
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Xuất bản ở MuseScore (https://musescore.org)

Đây là sổ tay hướng dẫn cho phiên bản MuseScore 2.0 và cao hơn. Nó được duy trì bởi cộng đồng
MuseScore. Tìm hiểu xem bạn có thể giúp gì.

Khởi động
Chương này sẽ giúp bạn cài đặt và chạy MuseScore trong lần đầu tiên. Nó cũng hướng dẫn bạn cách
tạo một bản nhạc mới.

Cài đặt

This translation is outdated, see the English version for a reference: Installation

MuseScore làm việc được trên nhiều hệ thống máy tính khác nhau bao gồm Windows, Mac OS X, và
Linux.

Windows

Cài đặt

Bạn có thể lấy gói cài đặt trên Windows từ trang tải về này của MuseScore. Nhấp trên liên kết này để
bắt đầu tải về. Trình duyệt mạng của bạn sẽ yêu cầu bạn xác nhận rằng bạn muốn tải tập tin này về
không. Nhấp Save File.

Khi việc tải về hoàn thành, nhấp đôi trên tập tin này để bắt đầu cài đặt. Windows có thể sẽ yêu cầu
bạn xác nhận việc này trong một cửa sổ bảo mật trước khi chạy phần mềm này. Nhấp Run để tiếp tục,
sau đó bạn sẽ thấy

ngay sau đó là
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và

Nếu bạn nhấp Cancel, ở đây hoặc sau đó, bạn sẽ thấy:
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Thay vì thế nếu bạn nhấp Next để tiếp tục, trình dẫn cài đặt sẽ hiển thị các điều khoản của giấy phép
đối với phần mềm miễn phí này.

Hãy chọn I accept the terms in the License Agreement  và nhấp vào Next để tiếp tục. Tiếp theo nó
sẽ xác nhận vị trí để cài đặt MuseScore.
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Nếu muốn cài đặt phiên bản mới hơn của MuseScore những vẫn muốn giữ lại phiên bản cũ, thì bạn
phải chọn một thư mục cài đặt khác (phiên bản 2.0 và 1.x có thể cùng tồn tại và không ghi đè lên
nhau, vì vậy không cần thay đổi gì đối với hai phiên bản này). Mặt khác hãy nhấp Next để tiếp tục.

Nhấp vào Install để tiếp tục.

Đợi vài phút để trình dẫn cài đặt thiết lập cấu hình và các tập tin cần thiết. Sau đó bạn thấy
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rồi tới

và cuối cùng
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Nhấp vào Finish để thoát cài đặt. Bây giờ bạn có thể xóa tập tin cài đặt mà bạn đã tải về.

Khởi động MuseScore

Để khởi động MuseScore chọn vào Start → All Programs → MuseScore 2 → MuseScore 2.

Gỡ bỏ MuseScore

Bạn có thể gỡ bỏ trên Windows 32-bit bằng cách

    cd C:\Program Files\MuseScore
    Uninstall.exe /S

và trên Windows 64-bit bằng cách

    cd C:\Program Files (x86)\MuseScore
    Uninstall.exe /S

Mac OS X

Cài đặt

Bạn sẽ thấy tập tin DMG trên trang tải về của MuseScore. Nhấp trên liên kết đó để bắt đầu tải về.

12

https://musescore.org/vi/node/20300


1. Kéo và thả biểu tượng MuseScore vào biểu tượng thư mục Applications. Nếu bạn không đăng
nhập như administrator, Mac OS X có thể sẽ hỏi bạn mật khẩu: nhấp vào Authenticate và nhập
mật khẩu để xử lý.

2. Bạn có thể chạy MuseScore từ thư mục Applications, Spotlight, hoặc Launchpad.

Gỡ bỏ

Đơn giản là xóa MuseScore trong thư mục Applications.

Linux

Vui lòng xem trang tải về này để có hướng dẫn thích hợp cho MuseScore trên Linux. Các gói cái đặt
được cung cấp cho Debian, Ubuntu, Fedora và PCLinuxOS. Những bản phân phối khác bản sẽ phải
tự làm từ mã nguồn. Những chỉ dẫn riêng biệt cho Fedora, xem bên dưới.

Fedora

1. Nhập GPG key:

su
rpm --import http://prereleases.musescore.org/linux/Fedora/RPM-GPG-KEY-Seve

2. Tới trang tải về của MuseScore. Nhấp vào liên kết tải về bản ổn định cho Fedora và chọn chính
xác gói rpm cho kiến trúc máy của bạn.

3. Tùy thuộc vào kiến trúc máy của bạn, sử dụng một trong hai tập lệnh này để cài đặt MuseScore

đối với arch i386

su
yum localinstall musescore-X.Y-1.fc10.i386.rpm

đối với arch x86_64

su
yum localinstall musescore-X.Y-1.fc10.x86_64.rpm

Nếu bạn có vấn đề về âm thanh, hãy xem Fedora 11 và âm thanh
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Tham khảo thêm

Cách thay đổi ngôn ngữ trong MuseScore
Cách cài đặt MuseScore trên Windows mà không có quyền administrator
Cách chạy MuseScore với quyền Administrator trên Windows

Do you have an unanswered question? Post it in the forum.

Tạo bản nhạc mới
Lúc khởi chạy MuseScore, bạn sẽ thấy cửa sổ Trung Tâm Khởi Tạo.

Trung tâm khởi tạo

Bạn có thể chọn một trong các lựa chọn sau

Tạo bản nhạc mới (bằng cách dùng biểu tượng có ký hiệu dấu cộng)
Mở bản nhạc đã mở lần trước
Mở bản nhạc đang tồn tại
Xem bản nhạc nổi bật 'In the spotlight' trong ngày
Tìm một bản nhạc trên musecore.com
Liên kết tới các ứng dụng di động
Liên kết tới MuseScore trên các mạng xã hội bên dưới

Tạo bản nhạc mới

Để tạo bản nhạc mới từ trình đơn chính (thay vì từ Trung Tâm Khởi Tạo) chọn Tập tin → Tạo mới...,
nó sẽ mở cửa sổ trình dẫn Tạo Bản Nhạc Mới.

Tên bài nhạc, nhạc sĩ và thông tin khác
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Nhập tên bài, nhạc sĩ, hoặc những thông tin khác hiện ở trên, sau đó nhấp vào Tiếp theo> và bạn sẽ
thấy:

Tại đây bạn chọn một kiểu mẫu để tạo bản nhạc mới. Các kiểu mẫu sẽ được thảo luận chi tiết hơn
bên dưới, nhưng bây giờ hãy chọn "Chọn các nhạc cụ", nó sẽ đưa bạn sang bước kế tiếp.

Các nhạc cụ và các bè
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Cửa sổ nhạc cụ được chia thành hai cột. Cột bên trái liệt kê các nhạc cụ hoặc âm giọng để lựa chọn.
Cột bên phải, lúc đầu sẽ trống, nhưng sau đó sẽ chứa danh sách các nhạc cụ trong bản nhạc mới của
bạn.

Danh sách nhạc cụ trong cột bên trái được phân loại theo từng họ hay bộ nhạc cụ. Nhấp vào một bộ
để hiện đầy đủ danh sách nhạc cụ của từng họ. Chọn một nhạc cụ và nhấp vào Thêm. Nhạc cụ được
chọn bây giờ đã hiện trong cột phải. Bạn có thể thêm các nhạc cụ hoặc âm giọng khác nếu cần.

Danh mục mặc định sẽ là "Nhạc cụ thông dụng" nhưng bạn có thể chọn một cái khác, bao gồm 'Nhạc
cụ Jazz' và 'Nhạc cụ cổ'.

Kiểu khuông nhạc thường là dạng chuẩn (5 dòng kẻ), nhưng một vài nhạc cụ có thể dùng các kiểu
khác (trống/bộ gõ, khảy dây).

Thứ tự các nhạc cụ trong cột phải sẽ phản ánh cách chúng hiển thị trong bản nhạc. Để thay đổi thứ
tự đó, nhấp vào tên một nhạc cụ và sử dụng nút Lên hoặc Xuống để di chuyển nó lên cao hoặc thấp
hơn. Khi hoàn thành, nhấp vào Tiếp theo >.

Thêm khuông nhạc nối kết cho một nhạc cụ

16

https://musescore.org/sites/musescore.org/files/Create_new_score-Add-instruments_vi.png
https://musescore.org/sites/musescore.org/files/Create_new_score-Add_linked_staff_vi.png


Tùy chọn: Nhấp vào một khuông nhạc trong danh sách các nhạc cụ đã thêm vào, sau đó nhấp nút
Thêm khuông nối kết.

Chọn hóa biểu và nhịp độ

Trình dẫn yêu cầu hai thứ: Hóa biểu khởi tạo và nhịp độ của bản nhạc. Chọn bất kỳ một mẫu và nhấp
vào nút Tiếp theo > để tiếp tục. Việc khởi tạo một nhịp độ cũng có thể được tạo ở đây.

Số chỉ nhịp, ô nhịp lấy đà (anacrusis), và số lượng ô nhịp

Bạn có thể tạo số chỉ nhịp ban đầu ở đây. Nếu bản nhạc mở đầu là ô nhịp lấy đà thi bạn hãy đánh
dấu vào ô đánh dấu "Ô nhịp lấy đà" và điều chỉnh số chỉ nhịp (đây là mục trường độ thực tế, một thiết
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lập trong trình đơn ngữ cảnh 'Đặc tính ô nhịp').

Số lượng ô nhịp có thể được chỉ ra tại đây, nhưng nó cũng có thể được sửa đổi lại sau.

Nhấp vào Hoàn thành để tạo bản nhạc mới.

Ghi chú: ô nhịp hay còn gọi là khuông nhịp, đừng nhầm lẫn với khuông nhạc

Điều chỉnh bản nhạc sau khi tạo

Bạn có thể thay đổi bất kỳ một thiết lập nào đã xuất hiện trong trình dẫn tạo bản nhạc mới, thậm chí
ngay cả khi bạn đang làm việc trên bản nhạc.

Để thêm/xóa các ô nhịp hoặc tạo ô nhịp lấy đà, hãy xem Các thao tác trên ô nhịp

Để thay đổi bất ký một chữ viết nào, hãy xem Chỉnh sửa chữ viết. Để thêm Tên bản nhạc còn
thiếu (hay các dòng chữ khác), hãy dùng trình đơn Thêm → Chữ viết → Tựa đề (hoặc các mục
chữ khác)

Để thêm, xóa, hay thay đổi thứ tự của các nhạc cụ hãy dùng trình đơn Điều chỉnh → Nhạc
cụ....

Các kiểu mẫu

Tại màn hình đầu tiên của trình dẫn tạo bản nhạc mới có một tùy chọn để "Tạo bản nhạc mới từ kiểu
mẫu" (xem ở trên để biết chi tiết). Để tạo một bản nhạc theo cách này, hãy chọn một kiểu mẫu để tiếp
tục.

Ở màn hình tiếp theo hiển thị một danh sách các kiểu mẫu. Chọn một kiểu mẫu và nhấp Tiếp theo >.
Tiếp tục và hoàn thành trình dẫn như thông thường.

Đây cũng chỉ là những tập tin MuseScore bình thường, được lưu trữ trong thư mục kiểu-mẫu hay
templates (một cái là của hệ thống và một cái là của cá nhân). Bạn cũng có thể tạo những kiểu mẫu
riêng cho mình bằng cách lưu các bản nhạc vào các thư mục này.

Trên hệ điều hành Windows, thư mục kiểu-mẫu của hệ thống thì thường là C:\Program
Files\MuseScore 2\templates hoặc trong phiên bản 64-bit thì là C:\Program Files (x86)\MuseScore
2\templates.

Trên Linux, thì là /usr/share/mscore-xxx nếu bạn cài đặt từ bộ quản lý gói. Nếu bạn tự biên dịch
MuseScore trên Linux, thì hãy xem tại /usr/local/share/mscore-xxx (với xxx là phiên bản bạn đang
sử dụng).

Trên Mac, thì xem tại /Applications/MuseScore 2.app/Contents/Resources/templates.

Bạn có thể cấu hình vị trí thư mục kiểu mẫu cá nhân của mình trong trình đơn Điều chỉnh → Thiết
lập... → Tổng quát, MuseScore sẽ hiển thị các kiểu mẫu từ cả hai, một của hệ thống và một của cá
nhân.

Tham khảo thêm

Hóa biểu
Số chỉ nhịp
Khóa nhạc
Nhịp độ
Các thuộc tính của kiểu khuông nhạc

Những liên kết khác

Vi-deo hướng dẫn: Vài phút với MuseScore: Bài 1 - Thiết lập bản nhạc

Start_center_vi.png
Create_new_score-Title_vi.png
Create_new_score-Time_signature_vi.png
Create_new_score-Select_template_vi.png
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Create_new_score-Key_signature_vi.png
Create_new_score-Add-instruments_vi.png
Create_new_score-Add_linked_staff_vi.png

Do you have an unanswered question? Post it in the forum.

Thiết lập ngôn ngữ và cập nhật bản dịch
MuseScore sẽ được cài đặt và hoạt động trong ngôn ngữ của "Hệ thống" (một lựa chọn được dùng
bởi hầu hết các chương trình, và thông thường phụ thuộc vào ngôn ngữ và quốc gia đã được thiết
lập trên máy tính của bạn hay tài khoản).

Thay đổi ngôn ngữ

1. Đi tới Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết lập...)

2. Trong thẻ Tổng quát , có một khu vực là Ngôn ngữ :

Bạn có thể thay đổi và cập nhật bản dịch bằng nút Cập nhật bản dịch. Một cửa sổ xuất hiện, hiển thị
ngôn ngữ của bạn trên cùng - xem bên dưới.

Sau khi chỉ định xong, bạn sẽ phải thoát và mở lại MuseScore để những thay đổi và cập nhật có hiệu
lực.

Cập nhật bản dịch

Bạn có thể cập nhật bản dịch như đã giải thích ở trên, nhưng có một cách khác là:

1. Đi tới Hỗ trợ → Quản lý tài nguyên...

2. Nhấp vào nút 'Cập nhật'
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Tại đây bạn cũng phải thoát và mở lại MuseScore để việc cập nhật có hiệu lực.

Xem thêm

Trợ giúp và cải thiện bản dịch

Preferences-General_vi.png
Resource_Manager-Resources_vi.png

Do you have an unanswered question? Post it in the forum.

Kiểm tra cập nhật
Có hai cách để kiểm tra cập nhật.

Kiểm tra cập nhật tự động

1. Đi tới Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết lập...)
2. Chọn thẻ Cập nhật

3. Chọn vào 'Check for new version of MuseScore'
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Bây giờ MuseScore sẽ kiểm tra cập nhật mỗi lần chạy và thông bào cho bạn nếu cần.

Kiểm tra cập nhật

1. Chọn Hỗ trợ → Kiểm tra Cập nhật

2. Một hộp thoại sẽ xuất hiện cho biết trạng thái cập nhật: hoặc là "Không có bản cập nhật" hoặc là
"MuseScore có phiên bản cập nhật:" theo sau là một liên kết để tải nó về.

Xem thêm

Thiết lập: Cập nhật

Check_for_update_vi.png
Prefecences-Updates_vi.png

Do you have an unanswered question? Post it in the forum.

Các thao tác cơ bản
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Chương "Khởi động" trước đã hướng dẫn các bạn cách cài đặt và xử lý việc tạo một bản nhạc mới.
Chương "Các thao tác cơ bản" này sẽ cho bạn thấy tổng quản về MuseScore và mô tả những cách
chung để tương tác với bản nhạc.

Nhập nốt nhạc

Cách nhập nốt cơ bản

Việc thêm các nốt nhạc và dấu lặng vào khuông nhạc yêu cầu 4 bước cơ bản:

1. Chọn vị trí bắt đầu để nhập nốt
2. Chọn chế độ Nhập nốt
3. Chọn trường độ của nốt (hay dấu lặng) bạn muốn nhập
4. Nhập cao độ (hoặc dấu lặng) bằng phím tắt, chuột, hoặc bàn phím MIDI

Để thêm các nốt nhạc ở đầu/cuối tại các nhịp khác nhau (tính đa âm), hãy xem Các giọng. Đối với
gam-hợp âm, hãy đọc tiếp tại đây.

Bước 1: Điểm khởi đầu

Đầu tiên, chọn một nốt, hoặc dấu lặng trên bản nhạc là điểm khởi đầu của bạn cho việc nhập nốt. Chế
độ 'Nhập nốt' trong MuseScore sẽ thay thế các nốt/dấu-lặng hiện tại trong một ô nhịp (hay khuông
nhịp) bằng các nốt mới (tức là sẽ ghi đè thay vì chèn thêm vào). Tuy nhiên, bạn có thể chèn thêm các
ô nhịp mới tại bất kỳ đâu (xem mục Các thao tác trên ô nhịp: Chèn thêm), hoặc dùng sao chép và dán
để di chuyển một đoạn các nốt nhạc.

Bước 2: Chế độ 'Nhập nốt'

Nút có hình chữ "N" trên thanh công cụ Nhập nốt cho biết bạn đang ở trong chế độ Nhập nốt hay
không. Để kích hoạt hoặc rời khỏi chế độ Nhập nốt, bạn có thể nhấp vào nút này, hoặc bạn có thể
dùng phím tắt N. Để rời khỏi chế độ Nhập Nốt, bạn có thể nhấn phím Esc.

Bước 3: Về trường độ của nốt nhạc (hay dấu lặng)

Sau khi kích hoạt chế độ Nhập Nốt, chọn trường độ bạn cần từ thanh công cụ Nhập Nốt, hoặc dùng
phím tắt tương ứng.
Chú ý rằng nếu bạn có sự phân chia tiết tấu bất thường (giống như 3 nốt móc đơn nằm trong thời
gian của chỉ 2 nốt), xem mục Chùm liên

Các phím tắt để chọn trường độ như sau:

1: móc bốn (hemidemisemiquaver)
2: Móc ba (demisemiquaver)
3: Móc đôi (semiquaver)
4: Móc đơn (quaver)
5: Nốt đen (crotchet)
6: Nốt trắng (minim)
7: Nốt tròn (semibreve)
8: Tròn kép (breve)
9: Longa
0: Dấu lặng
.: Chấm dôi

Bước 4: Nhập cao độ

Đối với tất cả nhạc cụ (ngoại trừ bộ gõ không cao độ), bạn có thể thêm các cao độ của nốt bằng cách
dùng chuột, nhấp trực tiếp trên khuông nhạc. (Các chỉ dẫn riêng biệt đối với bộ gõ xem mục Ký âm
cho trống). Tuy nhiên, bạn có thể nhập nó nhanh hơn bằng một bàn phím MIDI (xem bên dưới), hoặc
bàn phím máy tính. Các ví dụ dưới đây sử dụng cách thứ hai.

Nhập cao độ bằng cách gõ các phím chữ cái tương ứng trên bàn phím: C D E F G A B C
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0 (Số không) tạo một dấu lặng: ví dụ, gõ C D 0 E sẽ cho kết quả như bên dưới. Để ý rằng trường độ
bạn chọn cho các nốt nhạc (trong ví dụ này là các nốt đen/crotchet) cũng quyết định trường độ của
dấu lặng (dấu lặng đen/crotchet).

Trong quá trình nhập nốt, con trỏ sẽ tự động tiến về phía trước trong bản nhạc. Nếu bạn muốn nhập
một gam hay một chồng nốt, nhấn giữ Shift và nhập tên nốt, ví dụ: C D Shift+F Shift+A E F

Để tạo các gam hay chồng nốt với các trường độ khác nhau, xem mục Các giọng.

Nếu bạn muốn tạo nốt có chấm, nhấn phím .. Ví dụ 5 . C 4 D E F G A

Khi bạn gõ một nốt trên bàn phím, MuseScore sẽ đặt nó ở cao độ gần nhất so với nốt vừa nhập trước
đó (ở trên hoặc ở dưới). Tuy vậy khi nhập một gam, các nốt mới luôn được thêm vào ở trên nốt hiện
tại (hướng từ dưới lên).
Nếu có nốt nào nằm sai quãng tám, thì di chuyển nó lên hoặc xuống bằng cách dùng tổ hợp phím tắt
bên dưới:

Ctrl+↑ (Mac: ⌘+↑): Tăng nốt nhạc lên quãng tám.
Ctrl+↓ (Mac: ⌘+↓): Giảm nốt nhạc xuống quãng tám.

Các phím tắt khác

Các phím tắt hữu dụng khác dùng trong chế độ Nhập Nốt là:

↑ (Lên): Tăng nốt nhạc lên nửa cung (dùng ♯).
↓ (Xuống): Giảm nốt nhạc xuống nửa cung (dùng ♭).
Alt+Shift+↑: Tăng cao độ nốt sử dụng hóa biểu
Alt+Shift+↓: Giảm cao độ nốt sử dụng hóa biểu
J: Chuyển một nốt thành nốt trùng âm
R: Nhân đôi một nốt
Q: Giảm nửa trường độ của một nốt
W: Nhân đôi trường độ của một nốt
Backspace: Hoàn lại thao tác nhập nốt cuối
X: Đảo chiều thân nốt nhạc
Shift+X: Đảo hướng đầu nốt

Bàn phím MIDI

Bạn cũng có thể nhập cao độ bằng bàn phím MIDI.

1. Kết nối bàn phím MIDI tới máy tính và bật bộ cảm biến lên
2. Khởi chạy MuseScore (điều này phải được hoàn thành sau khi bàn phím đã mở)
3. Tạo bản nhạc mới
4. Nhấp vào dấu lặng (selecting it) trong ô nhịp 1 để chỉ định nơi bạn muốn bắt đầu nhập nốt
5. Nhấn N để kích hoạt chế độ Nhập Nốt
6. Chọn trường độ nốt nhạc ví dụ như 5 là nốt đen (crotchets), như được mô tả ở trên
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7. Nhấn một nốt trên bàn phím MIDI

Cao độ nên xuất hiện trên bản nhạc của bạn.

Ghi chú: Bàn phím MIDI có thể nhập một nốt hoặc gam cùng một thời điểm. Chế độ nhập nốt này
(thường gọi là "nhập từng bước") thì nhanh và chính xác. Một vài phần mềm ký âm cố gắng thực
hiện chế độ "nhập theo thời gian thực", trong chế độ này nhạc sỹ sẽ chơi một đoạn nhạc và phần
mềm sẽ cố gắng viết lại các ký âm. Tuy nhiên, các kết quả nhìn chung không được chính xác.
MuseScore thì tập trung vào các kiểu nhập nốt chính xác hơn.

Nếu bạn có nhiều thiết bị MIDI kết nối tới máy tính, có thể bạn cần chỉ cho MuseScore biết cái nào là
bàn phím MIDI. Đi tới Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết lập...). Trong hộp thoại
thiết lập, nhấp trên thẻ Nhập/Xuất âm thanh và chọn thiết bị của bạn bên dưới khu vực có tên
"PortAudio".

Tô màu các nốt nhạc nằm ngoài phạm vi của nhạc cụ

Các nốt nằm trong phạm vi có thể chơi được bởi một nhạc cụ hay một âm giọng sẽ có màu đen, còn
các nốt nằm ngoài phạm vi bình thường này sẽ có màu đỏ. Một vài nhạc cụ, phạm vi này phụ thuộc
vào kỹ năng của người chơi. Với những nhạc cụ này, các nốt nằm ngoài phạm vi của một người chơi
nghiệp dư sẽ hiển thị màu vàng, và những nốt nằm ngoài phạm vi đặc thù của một người chơi
chuyên nghiệp sẽ hiện thị màu đỏ.

Những màu này chỉ là thông tin và chỉ xuất hiện trên màn hình máy tính, nhưng sẽ không thể hiện
trên bản in. Để tắt chế độ tô màu nốt, vào Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết
lập...), nhấp vào thẻ Nhập nốt, và bỏ chọn mục "Tô màu các nốt nằm ngoài âm vực cho phép".

Làm nhỏ nốt nhạc

1. Chọn các nốt muốn làm nhỏ lại
2. Trong bảng kiểm soát bạn có thể thay đổi kích cỡ riêng cho từng nốt cũng như cho các gam

bằng cách chọn vào ô "Nhỏ" (trong khu vực Hợp âm hoặc Nốt nhạc của bảng kiểm soát)
Bạn có thể chỉnh lại tỷ lệ của các kích cỡ nhỏ (thậm chí không theo quy ước) trong trình đơn
Định kiểu → Tổng quát → Kích cỡ

Ghi chú: Trong bản kiểm soát, ô 'Nhỏ' trong khu vực 'Nốt nhạc' chỉ làm nhỏ kích cỡ của đầu nốt; còn
trong khu vực 'Hợp âm', thân nốt, dấu nối-cờ-nốt, và cờ nốt, tất cả đều được nhỏ lại.

Thuộc tính của nốt nhạc

Xem mục Trình bày và định dạng, đặc biệt các phần nói về Nốt nhạc, dấu hóa bất thường và
Dấu liên
Xem mục Bảng kiểm soát và các thuộc tính của đối tượng để biết các thuộc tính của một nốt
nhạc hoặc của vùng chọn các nốt

Thay đổi nốt nhạc (mà không đổi tiết tấu)

Nếu chỉ có một nốt, cách tốt nhất và chọn nó và thay đổi bằng chuột hoặc bàn phím.
Nếu có hơn một nốt và không muốn thay đổi tiết tấu, bạn có thể sử dụng chuyển tông (nếu quãng
dịch hoàn toàn giống nhau), hoặc sử dụng chế độ hiệu chỉnh cao độ.

Xem Chế độ nhập lại cao độ
Xem Sự chuyển tông hay giọng

Nếu các 'dấu hóa bất thường' có vẻ kỳ quặc, bạn có thể thử chức năng 'Xác định lại cao độ' (xem Dấu
hóa bất thường: Xác định lại cao độ).

Xem thêm

Ký âm cho trống
Thiết lập
Chùm liên
Các giọng
Cách để nhập gam
Cách để nhập dấu lặng
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Cách giãn thân nốt qua hai khuông nhạc

Các liên kết khác

Vi-deo hướng dẫn: Vài phút cùng MuseScore: Bài 3 - Nhập nốt
Vi-deo hướng dẫn: Vài phút cùng MuseScore: Bài 4 - Nhập bằng bàn phím MIDI
Vi-deo hướng dẫn: Vài phút cùng MuseScore: Bài 5 - Vài khái niệm nhập khác

Do you have an unanswered question? Post it in the forum.

Cao độ theo âm
Chức năng Cao độ theo âm cho phép chuyển các nốt ký âm trên khuông nhạc của chúng, thành các
nốt có cao độ đúng với âm thanh của nhạc cụ phát ra, và các "nhạc cụ dị tông" (hay nhạc cụ chuyển
vị) thì cần đến chúng để được viết ra. Điều này có lẽ sẽ thay đổi hóa biểu và/hoặc khóa nhạc cho phù
hợp với các "nhạc cụ dị tông".

Chú ý: Trước khi in ấn, nếu như bạn có các nhạc cụ dị tông trong bản nhạc, bạn phải chắc chắn rằng
các bè nhạc không ở trong chế độ 'cao độ theo âm'.

"Nhạc cụ dị tông" ví dụ như: cla-ri-net B♭

Xem thêm

Sự chuyển tông: Các nhạc cụ dị tông
Dấu hóa bất thường: Xác định lại cao độ

Concert_pitch_button_vi.png
Do you have an unanswered question? Post it in the forum.

Sao chép và dán
Sao chép và dán là công cụ rất hữu dụng để viết lặp lại một đoạn nhạc nào đó, hoặc để dịch một đoạn
nhạc đi một phách hay một ô nhịp.

Sao chép

1. Nhấn Chuột trái trên nốt đầu tiên của vùng muốn chọn
2. Shift+Chuột trái trên nốt cuối cùng của vùng muốn chọn. Một khung chữ nhật màu xanh lam

sẽ tô sáng vùng bạn đã chọn
3. Từ trình đơn, chọn Điều chỉnh → Sao chép hoặc nhấn Ctrl+C (Mac: ⌘+C)

Dán

1. Nhấn Chuột trái vào một nốt nhạc hoặc một ô nhịp nơi bắt đầu cho vùng cần dán.
2. Từ trình đơn, chọn Điều chỉnh → Dán hoặc nhấn Ctrl+V (Mac: ⌘+V)

Nhân bản nhanh

1. Chọn một nốt hoặc ô nhịp
2. Nhấn R và rồi MuseScore sẽ nhân đôi đối tượng đã chọn

Bộ lọc cho vùng được chọn

Có thể dùng bộ lọc trước khi sao chép một vùng đã chọn, để có thể chọn được chính xác những gì
sẽ được sao chép và dán sau đó.

1. Để mở bảng "Bộ lọc cho vùng được chọn" nhấn F6 (Mac: fn+F6) hoặc vào Xem → Bộ lọc cho
vùng được chọn
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Bộ lọc cho vùng được chọn nhìn giống thế này:

Thẻ Bộ lọc cho vùng được chọn mặc định sẽ xuất hiện bên dưới thẻ "Các bảng công cụ". Nó có thể
tách ra và tạo thành một cửa sổ riêng, và nếu kéo nó trực tiếp lên trên thẻ "Các bảng công cụ", hay
"Bảng kiểm soát", thì cả hai sẽ hiển thị theo dạng thẻ ở phía dưới cửa sổ.

1. Bỏ chọn những thứ bạn không muốn sao chép
Ví dụ: Các Dấu diễn đạt và Dấu luyến không được chọn.
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2. Sao chép và dán như mục trước
(trong ví dụ này, sao chép ô nhịp 4 và 5 rồi dán nó vào ô nhịp 12 và 13)

3. Hãy xem kết quả này—dấu luyến đã không được sao chép:
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Xem thêm

Nếu muốn thay đổi nốt nhạc mà không thay đổi tiết tấu, bạn có thể dùng chức năng chuyển tông hoặc
chế độ nhập lại cao độ kết hợp với chức năng sao chép và dán.

Những liên kết khác

Vi-deo hướng dẫn: Lời bản nhạc, việc sao chép & dấu cường độ

View_vi.png
Selection filter 1-vi.png
Selection filter 2-vi.png
Selection filter result_vi.png

Do you have an unanswered question? Post it in the forum.

Chế độ điều chỉnh
Rất nhiều đối tượng trong bản nhạc có thể được chỉnh sửa trong Chế độ điều chỉnh:

Nhấp đôi chuột để: Bắt đầu Chế độ điều chỉnh
Nhấn Esc để: Kết thúc Chế độ điều chỉnh

Một vài đối tượng có các điểm điều khiển trong chế độ điều chỉnh, nó có thể được di chuyển bằng
cách kéo chuột hay các lệnh từ bàn phím.

Dấu luyến trong Chế độ điều chỉnh:

Các lệnh từ bàn phím có thể dùng:

←: Dịch điểm điều khiển sang trái một Khe-nhạc (khoảng cách giữa hai dòng kẻ của khuông
nhạc)
→: Dịch điểm điều khiển sang phải một Khe-nhạc
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↑: Dịch điểm điều khiển lên một Khe-nhạc
↓: Dịch điểm điều khiển xuống một Khe-nhạc
Ctrl+← (Mac: ⌘+←): Dịch điểm điều khiển sang trái 0.1 Khe-nhạc
Ctrl+→ (Mac: ⌘+→): Dịch điểm điều khiển sang phải 0.1 Khe-nhạc
Ctrl+↑ (Mac: ⌘+↑): Dịch điểm điều khiển lên 0.1 Khe-nhạc
Ctrl+↓ (Mac: ⌘+↓): Dịch điểm điều khiển xuống 0.1 Khe-nhạc
Alt+←: Dịch điểm điều khiển sang trái 0.01 Khe-nhạc
Alt+→: Dịch điểm điều khiển sang phải 0.01 Khe-nhạc
Alt+↑: Dịch điểm điều khiển lên 0.01 Khe-nhạc
Alt+↓: Dịch điểm điều khiển xuống 0.01 Khe-nhạc
Shift+←: Dịch điểm neo của điểm điều khiển sang trái
Shift+→: Dịch điểm neo của điểm điều khiển sang phải
Tab: Nhảy tới điểm điều khiển kế tiếp

Nếu muốn di chuyển các đối tượng trong bản nhạc bằng tay, hãy nhấp đôi vào nó và dùng các phím
mũi tên (phím định hướng).

Xem thêm

Điều chỉnh chữ viết
Dấu luyến
Ngoặc nối khuông nhạc
Đường kẻ hay nét vẽ
Dấu nối-cờ-nốt
Dấu biến cường

Do you have an unanswered question? Post it in the forum.

Các thao tác trên ô nhịp

Nối thêm

Để thêm một ô nhịp vào cuối bản nhạc, nhấn Ctrl+B (Mac: ⌘+B), hoặc từ trình đơn, chọn Thêm → Ô
nhịp → Nối thêm một ô nhịp. Để thêm nhiều ô nhịp, nhấn Alt+Shift+B (Mac: Option+Shift+B) hoặc từ
trình đơn Thêm → Ô nhịp → Nối thêm nhiều ô nhịp....

Chèn thêm

Chọn một ô nhịp, sau đó nhấn phím Ins hoặc dùng trình đơn Thêm → Ô nhịp → Chèn một ô nhịp để
chèn thêm một ô nhịp rỗng nằm đằng trước ô được chọn. Để chèn nhiều ô nhịp, nhấn Ctrl+Ins
(không có phím tắt cho Mac) hoặc từ trình đơn, chọn Thêm → Ô nhịp → Chèn nhiều ô nhịp....

Xóa bỏ

Chọn ô nhịp, sau đó nhấn Ctrl+Del (Mac: ⌘+Fn+Del).

Các đặc tính

Để chỉnh sửa các đặc tính của một ô nhịp, nhấp phải chuột vào chỗ trống của ô nhịp và chọn Đặc tính
ô nhịp...:
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Khuông nhạc

Thuộc tính hiển thị cho phép bạn ẩn/hiện các nốt và các dòng kẻ khuông đối với ô nhịp hiện tại.
Thuộc tính ẩn thân nốt cho phép bạn ẩn/hiện tất cả thân nốt đối với ô nhịp hiện tại. Chú ý, bình
thường thì một nốt sẽ có một thân nốt ví dụ nốt trắng (minims) và nốt đen (crotchets) nhưng khi
được đánh dấu là 'ẩn thân nốt' thì chỉ còn hiện đầu nốt mà thôi.

Trường độ của ô nhịp

Thuộc tính Trên mặt chữ là số chỉ nhịp hiển thị trên bản nhạc.
Bạn có thể thay đổi thuộc tính Thực tế của ô nhịp thành bất kỳ số chỉ nhịp nào.
Bình thường, thuộc tính trên-mặt-chữ và thực-tế của ô nhịp là giống nhau. Tuy nhiên, một ô nhịp
(ví dụ: ô nhịp lấy đà, anacrusis) có thể có trường độ thực-tế ngắn hơn.

Trong hình dưới, ô nhịp lấy đà chứa nốt đen (crotchet) có trường độ ô nhịp trên-mặt-chữ là 4/4,
nhưng trường độ thực-tế là 1/4. Các ô nhịp trong giữa thì có trường độ thực-tế và trên-mặt-chữ là
4/4. Ô nhịp cuối chỉ chứa một nốt trắng có chấm, lại có trường độ thực-tế là 3/4:

Những thuộc tính khác

Loại khỏi bộ đếm ô nhịp 
Sử dụng thuộc tính "Loại khỏi bộ đếm ô nhịp" đối với những ô nhịp "bất thường", tức là những ô
nhịp này không nên tính trong việc đánh số cho ô nhịp. Bình thường, một ô nhịp lấy đà sẽ được
đánh dấu là "Loại khỏi bộ đếm ô nhịp".

Tăng chỉ số ô nhịp lên 
Bạn có thể dùng thuộc tính "Tăng chỉ số ô nhịp lên" để tác động tới việc đánh số cho ô nhịp. Bạn
có thể nhập một số dương hoặc âm ở đây. Chú ý, việc làm này sẽ gây ảnh hưởng tới những ô
nhịp phía sau. Nếu nhập giá trị là "-1" thì kết quả cũng giống như việc bạn đánh dấu một ô nhịp
là "loại khỏi bộ đếm ô nhịp".

Độ giãn 
Với thuộc tính này bạn có thể tăng, hoặc giãn không gian chiều ngang giữa các đối tượng của
bản nhạc (các nốt nhạc, dấu lặng, v.v..).
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Số lần lặp lại 
Nếu ô nhịp này nằm ngay trước một dấu lặp, bạn có thể định rõ nó được chơi mấy lần.

Không dùng dấu-lặng-đa-ô-nhịp 
Thuộc tính sẽ tách một dấu lặng đa ô nhịp tại điểm bắt đầu của ô nhịp được chọn. Tùy chọn này
nên được đánh dấu trước khi bạn bật tùy chọn "Tạo dấu lặng đa ô nhịp" trong Định kiểu →
Tổng quát..., trong thẻ "Bản nhạc".
Dấu lặng đa ô nhịp sẽ tự động được hủy tại những chỗ ngắt quan trọng, ví dụ như nhãn diễn
lặp, những nơi số chỉ nhịp bị đổi, vạch nhịp kép, các ô nhịp bất thường, v.v.. Mặc định sẽ tắt
cho mọi bản nhạc, đối với các bè thì bật

Việc đánh số

MuseScore sẽ tự động đánh số cho các ô nhịp đầu tiên của từng dòng nhạc (ngoại trừ dòng nhạc đầu
tiên, thực sự là chỉ đối với ô nhịp số 1), nhưng vẫn có các tùy chọn đánh số khác. Từ trình đơn chính,
chọn Định kiểu → Tổng quát..., tại khung bên trái, chọn thẻ "Khung tin đầu trang, chân trang,
Đánh số ô nhịp". Tại cuối khung bên phải là khu vực "Đánh số ô nhịp" ("Chỉ số ô nhịp").

Đánh dấu vào ô "Đánh số cho ô nhịp" ("Chỉ số ô nhịp") để bật tính năng tự động đánh số cho ô nhịp.

Đánh dấu vào "Áp dụng cho cái đầu tiên" nếu bạn muốn hiện chỉ số ô nhịp cho ô nhịp đầu tiên.

Đánh dấu vào "Tất cả các khuông nhạc" nếu bạn muốn đánh số cho tất cả các khuông nhạc. Ngoài ra,
chỉ có khuông trên cùng của mỗi dòng nhạc sẽ hiển thị chỉ số ô nhịp.

Chọn vào "Đầu mỗi dòng nhạc" cái này sẽ đánh số tại ô nhịp đầu tiên của mỗi dòng, hoặc chọn mục
"Bước nhảy" để chỉ ra khoảng nhảy. Ví dụ, khoảng nhảy là mỗi 1 ô nhịp; hay khoảng nhảy là cứ 5 ô
nhịp thì đánh chỉ số cho ô nhịp.

Tách và ghép

Có thể bạn sẽ muốn có một ô nhịp dài hơn bình thường, hoặc ngắn hơn. Bạn có thể thay đổi chỉ số ô
nhịp và số chỉ nhịp trong thuộc tính ô nhịp, nhưng giờ đã có tùy chọn mới để tách và ghép các ô nhịp.
Các dấu nối cờ nốt có thể sẽ tự động thay đổi.

Ghép ô nhịp

1. Chọn các ô nhịp bạn muốn nối
2. Điều chỉnh → Ô nhịp → Ghép các ô nhịp lại một

Chú ý: Nếu chỉ chọn một khuông nhạc, tất cả các ô nhịp trong mỗi khuông hoặc dòng nhạc sẽ được
ghép lại.

 

Tách ô nhịp

1. Chọn một nốt (hay gam)
2. Điều chỉnh → Ô nhịp → Tách ô nhịp

Chú ý: Nếu chỉ chọn một nốt trong một khuông, thì mỗi khuông của dòng nhạc sẽ được tách ra cùng
một chỗ.

Xem thêm

Cách xóa bỏ ô nhịp
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Cách mở rộng một ô nhịp qua nhiều dòng
Cách tạo bản nhạc không có số chỉ nhịp (và khóa nhạc)

Measure_Properties_vi.png
Do you have an unanswered question? Post it in the forum.

Bảng công cụ
Có thể ẩn/hiện bảng công cụ bằng trình đơn Xem → Bảng công cụ (hoặc dùng phím tắt F9).

Thêm các ký hiệu vào bản nhạc

Bạn có thể kéo thả các ký hiệu từ bảng công cụ lên trên các đối tượng trong bản nhạc.

Nhấp đôi vào một ký hiệu từ bảng công cụ cũng tương đương với việc kéo thả nó từng đối tượng
được chọn trên bản nhạc.

Ví dụ, bạn có thể thêm dấu tenuto cho một nhóm nốt như sau:

1. Chọn các nốt
2. Trong bảng công cụ "Dấu diễn đạt & Dấu hoa mỹ", nhấp đôi vào ký hiệu tenuto

Các bảng công cụ Cơ bản và Chi tiết

Có lẽ bạn muốn có thêm nhiều ký hiệu/bảng công cụ trong không gian làm việc của mình.
Xem mục

Nonexistent node nid: 39841.
để sửa đổi nhóm các bảng công cụ.

Các ký hiệu âm nhạc khác

Các ký hiệu âm nhạc khác có thể tìm thấy trong Bảng công cụ gốc.

Điều chỉnh một bảng công cụ

Để thêm các ký hiệu âm nhạc khác vào một bảng công cụ, xem mục Tùy chỉnh bảng công cụ.

Xem thêm

Tùy chỉnh bảng công cụ
Nonexistent node nid: 39841.
Bảng công cụ gốc

Do you have an unanswered question? Post it in the forum.

Thiết lập
Có lẽ bạn sẽ muốn có một định kiểu tổng quan hoặc các thư mục được chọn trước khi sử dụng
MuseScore.
Bạn có thể cài đặt điều này qua Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết lập...):
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Một cửa sổ thiết lập sẽ xuất hiện có các thẻ để di chuyển bên trong:

Một vài thay đổi có thể cần khởi động lại (thoát và mở lại) MuseScore thì mới có hiệu lực. Một hộp
thông báo sẽ hiện lên khi bạn nhấp vào Áp dụng hoặc Đồng ý.

Nút "Trả tất cả về mặc định" sẽ đưa chúng về một thiết lập mặc định của MuseScore lúc bạn cài đặt
chương trình.
Nút "Hủy bỏ" sẽ bỏ qua tất cả những thay đổi bạn vừa tạo ra.

Thẻ "Tổng quát"
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Tại đây bạn có thể định rõ:

Bản nhạc sẽ mở
Thư mục mặc định để tìm kiếm các bản nhạc của bạn, gói âm thanh, kiểu mẫu, và vân vân
Khoảng thời gian sẽ tự động lưu trữ
Ngôn ngữ sử dụng (các bản dịch cũng có thể cập nhật tại đây)
Định kiểu các cửa sổ MuseScore và kích thước các biểu tượng công cụ
Các cửa sổ sẽ mở khi khởi động (Bảng điều khiển chơi nhạc, Bộ điều hướng, Cửa sổ kết nối
MuseScore).
Chú ý việc cập nhật bản dịch cho ngôn ngữ cũng có thể được hoàn thành thông qua Hỗ trợ →
Quản lý tài nguyên

Thẻ "Bộ vẽ"
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Dùng thẻ "Bộ vẽ" để cài đặt màu và ảnh nền yêu thích của bạn cho nền bản nhạc và giấy.

Bên dưới mục Những thứ linh tinh, chọn Khử răng cưa (đã bật theo mặc định) sẽ làm các đường kẻ
xiên và các cạnh của các hình trông mượt hơn (bớt lởm chởm). Mục Vùng lân cận để chọn một vật
sẽ kiểm soát khoảng cách mà chuột vẫn còn có thể tác động trên một vật, khoảng cách này là từ
chuột tới vật. Số càng nhỏ đòi hỏi độ chính xác càng cao, sẽ khiến việc nhấp chọn khó hơn trên các
đối tượng nhỏ. Số càng lớn đòi hỏi độ chính xác càng thấp, vô tình sẽ khiến việc nhấp chọn khó hơn
trên các đối tượng gần nhau. Hãy chọn một giá trị làm việc thấy dễ chịu.

Thẻ "Nhập nốt"
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Trên thẻ này có các thiết lập nhập nốt và điều khiển MIDI từ xa. Tại đây có thể cài đặt những thứ bên
dưới:

Nhập nốt theo MIDI
Kích hoạt phát nốt nhạc khi nhập nốt
Trường độ phát của nó
Tô màu các nốt nằm ngoài âm vực cho phép
Các thiết lập điều khiển MIDI từ xa

Thẻ "Bản nhạc"
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Các thiết lập bản nhạc gồm có

Các tập tin danh sách nhạc cụ mặc định (có thể chọn cả hai)
Định kiểu mặc định cho bản nhạc và các bè
Tỷ lệ xem mặc định

Thẻ "Nhập/Xuất âm thanh"
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"Nhập/Xuất âm thanh" để thiết lập đầu vào và đầu ra cho âm thanh

Thẻ "Nhập dữ liệu"

Các thiết lập này sẽ quyết định việc nhập liệu từ các tập tin của các nguồn khác:
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Dùng định kiểu sẵn có trong MuseScore hoặc định kiểu mà bạn chọn
Bộ ký tự cho chương trình Guitar Pro và Overture
Các lựa chọn bố trí khi nhập từ MusicXML
Nốt ngắn nhất trong tập tin MIDI

Thẻ "Xuất dữ liệu"

Các thiết lập này sẽ quyết định những gì tập tin MuseScore sẽ xuất ra:

Độ phân giải ảnh PNG/SVG (trong đơn vị DPI) và có dùng lựa chọn nền trong suốt hay không
Có xử lý khai triển các dấu lặp khi xuất tập tin MIDI hay không
Tần số lấy mẫu âm thanh kỹ thuật số
Có xuất các bố trí và các ngắt dòng hay ngắt trang ra tập tin MusicXML hay không

Thẻ "Phím tắt"
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Mọi thao tác có thể làm trong MuseScore được liệt kê ở đây, một phím tắt sẽ được liên kết với nó nếu
có. Dùng nút "Định nghĩa..." để định nghĩa một phím tắt mới cho một thao tác. Bạn có thể sử dụng tối
đa 4 phím để định nghĩa một phím tắt.
Bạn có thể trả tất cả các phím tắt về mặc định, hoặc xóa một phím tắt mà bạn chọn.

(Chú ý một vài phím tắt trùng với phím tắt mặc định sẽ không thể được sử dụng với một vài bàn
phím. Hãy kiểm lại.)

Thẻ "Cập nhật"
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Cái này sẽ kiểm tra xem MuseScore có bản mới hay không lúc khởi chạy chương trình.

Bản cập nhật có thể kiểm tra thủ công tại trình đơn Hỗ trợ → Kiểm tra phiên bản mới của MuseScore

Xem thêm

Các phím tắt bàn phím
Thiết lập ngôn ngữ và cập nhật bản dịch
Kiểm tra cập nhật

Menu-Edit_vi.png
Preferences_Window_tabs_vi.png
Preferences-Canvas_vi.png
Preferences-Export_vi.png
Preferences-General_vi.png
Preferences-Import_vi.png
Preferences-IO_vi.png
Preferences-Note_Input_vi.png
Preferences-Score_vi.png
Preferences-Shortcuts_vi.png
Preferences-Updates_vi.png

Do you have an unanswered question? Post it in the forum.

Lưu trữ/Xuất dữ liệu/In ấn
Việc lưu trữ và xuất dữ liệu được tách thành hai mục: 'Lưu trữ' và 'Lưu trữ với' (cũng như 'Lưu một
bản sao' và 'Lưu phần đang chọn') đối với tập tin của riêng MuseScore (.mscz và .mscx) và 'Xuất bản
nhạc' (và 'Xuất các bè nhạc') đối với các định dạng không phải của riêng (MusicXML, MIDI, các định
dạng âm thanh và hiển thị khác). 'In ấn' là để đưa tập tin MuseScore tới máy in trong chương trình
MuseScore.

Trình đơn "Tập tin"
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Các mục có hiệu lực: 'Lưu trữ', 'Lưu trữ với...', 'Lưu một bản sao...', 'Lưu phần đang chọn...', 'Lưu trực
tuyến...', 'Xuất bản nhạc...', 'Xuất các bè nhạc...' và 'In ấn...'

Các định dạng trong trình đơn 'Lưu trữ', 'Lưu trữ với...', 'Lưu một bản sao...', 'Lưu phần đang chọn...' và 'Lưu trực
tuyến...'

Các định dạng trong trình đơn 'Xuất bản nhạc' (và 'Xuất các bè nhạc...')

42



Chú ý: Định dạng Uncompressed MuseScore thì có cả trong 'Lưu trữ' và 'Xuất bản nhạc'.

Trình đơn "In ấn"

Phụ thuộc vào máy in, bạn sẽ có các lựa chọn khác nhau. Nhìn chung các lựa chọn sau đều có sẵn:
page range - All, Selection, Current Page, hoặc Pages - number of copies and collation.
Nếu bạn có cài đặt máy in ảo PDF, bạn cũng có thể 'xuất' thành tập tin PDF theo cách này.

Xem thêm

Định dạng tập tin
Trích xuất các bè

Menu-File_vi.png
save_as_vi.png
export_vi.png

Do you have an unanswered question? Post it in the forum.

Các chế độ chọn
Có nhiều chế độ chọn khác nhau (nhiều cách để chọn các đối tượng).

Chỉ chọn một đối tượng

Chỉ cần nhấp chuột trên nó.

Chọn một dãy

1. Chọn đối tượng đầu tiên (hiểu là: nhấp chuột trên nó)
2. Nhấn Shift
3. Chọn (nhấp chuột) trên đối tượng cuối

Tất cả các đối tượng được chọn sẽ nằm trong khung chữ nhật màu xanh lam.

Chú ý 1: Một vài đối tượng có thể chọn thành dãy: Nốt nhạc, dấu lặng, dấu diễn đạt ...
Chú ý 2: Xem mục Sao chép và dán: Bộ lọc cho vùng được chọn để chọn chỉ những đối tượng cần
chọn trong dãy.

Chọn nhiều đối tượng không liền nhau

1. Chọn đối tượng đầu tiên (hiểu là: nhấp chuột trên nó)
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2. Nhấn và giữ Ctrl
3. Chọn (nhấp chuột) trên các đối tượng khác

Chú ý 1 ở trên vẫn áp dụng.

Chọn tất cả đối tượng tương tự

1. Chọn một đối tượng
2. Chuột phải trên nó vào → Chọn >

3. Vài lựa chọn có sẵn

Các đối tượng tương tự: trong toàn bộ bản nhạc
Các đối tượng tương tự trong cùng khuông: chỉ trong cùng khuông
Các đối tượng tương tự trong vùng đang chọn: chỉ nếu một →vùng chọn có hiệu lực,
chọn các đối tượng tương tự nằm trong vùng chọn đó
Thêm nữa...

Ví dụ: Một dấu giáng (dấu hóa bất thường) được chọn

Bạn có thể đánh dấu (và kết hợp) các lựa chọn bên dưới:

Cùng kiểu-phụ: trong ví dụ này chỉ các dấu giáng mới được chọn (không phải thăng cũng
không phải dấu bình); một vài đối tượng có kiểu-phụ (ví dụ dấu diễn đạt, dấu hóa bất
thường ...)
Cùng khuông: chỉ các đối tượng nằm trong cùng khuông nhạc
Cùng giọng: chỉ các đối tượng nằm cùng một giọng
Cùng dòng nhạc: chỉ các đối tượng nằm cùng dòng nhạc
Trong vùng được chọn: nếu một vùng chọn có hiệu lực, chỉ các đối tượng nằm trong vùng
chọn đó

Các thao tác khác có thể được thực hiện (chỉ chọn một): Thêm, Trừ đi, Thay thế và Tìm

Chúng dùng cho mục đích gì

Sao chép và dán
Chế độ điều chỉnh để Di chuyển đối tượng tương tự
Bảng kiểm soát và các thuộc tính của đối tượng

Xem thêm

Chương Các thao tác cơ bản , nhất là mục Nhập nốt nhạc
Chương Ký âm , nhất là mục Dấu hóa bất thường
Chương Chữ viết , nhất là mục Chỉnh sửa chữ viết và Di chuyển các ký hiệu và chữ viết khuông
nhạc dựa trên lưới

Select-More_vi.png
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Do you have an unanswered question? Post it in the forum.

Hoàn-tác và làm-lại
MuseScore có thể ghi nhớ số lượng thao tác hoàn-tác/làm-lại không giới hạn.

Phím tắt như dưới đây:

Hoàn tác:Ctrl+Z (Mac: ⌘+Z)
Làm lại:Ctrl+Shift+Z hoặc Ctrl+Y (Mac: ⌘+Shift+Z)

Hoặc sử dụng các nút trên thanh công cụ:

Do you have an unanswered question? Post it in the forum.

Các chế độ xem
Bạn có thể xem bản nhạc của mình trong các chế độ khác nhau.

Ngoại trừ chế độ xem "Xem-theo-trang/Xem-liền-dòng, tất cả các tùy chọn khác có thể thấy bên dưới
trình đơn Xem trong MuseScore.

Chế độ Xem-theo-trang/Xem-liền-dòng

Trong chế độ "Xem theo trang", bạn có thể thấy định dạng bản nhạc của mình giống như khi được in
hoặc khi xuất ra tập tin ảnh hay PDF. Còn chế độ "Xem liền dòng" , nguyên bản nhạc sẽ hiện thị trên
một dòng dài liên tục.

Chú ý khi chuyển qua lại giữa hai chế độ này, bản nhạc sẽ được định dạng lại cách nhìn và các điều
chỉnh trước đó bạn sẽ phải chỉnh lại.

Cách chuyển qua lại giữa hai chế độ:

Chế độ Xem-theo-trang

Trong chế độ này, bản nhạc hiện thị một hoặc nhiều trang theo kích cỡ chỉ định với lề trang của nó,
và bạn sẽ thấy được tất cả các ngắt dòng và ngắt trang, bao gồm các dấu ngắt bạn tự tay thêm vào
và những ngắt được tính toán tự động bởi chương trình. (Các ngắt trang mà bạn tự thêm có thể hữu
dụng để đặt các trang đúng chỗ cho các bè trong một dàn nhạc, đó là một ví dụ.)

Chế độ Xem-liền-dòng

Chế độ này sẽ hiển thị bản nhạc trên một dòng dài liên tục. Nếu điểm khởi đầu của bản nhạc không
còn nằm trong khung nhìn nữa, thì sẽ có một khung chữ nhật thay thế chứa chỉ số ô nhịp, tên nhạc
cụ, khóa nhạc, chỉ số nhịp và hóa biểu của bản nhạc được hiện lên.

Trước khi in ấn, hãy quay về chế độ "Xem theo trang" để kiểm lại các ngắt dòng và ngắt trang.
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Chú ý: Bởi vì sự bố trí thì đơn giản hơn nên có thể trong chế độ "Xem liền dòng" MuseScore sẽ thực
thi nhanh hơn trong chế độ "Xem theo trang".

Thu phóng

Trong chế độ "Xem theo trang" hay "Xem liền dòng", bạn có thể thay đổi cấp độ thu phóng ở đây (chú
ý: điều này không ảnh hưởng gì tới kích cỡ bản in).

Trong hộp trình đơn cuộn, bạn có thể chọn một tỷ lệ % hiển thị cho bản nhạc, hoặc là Khít Ngang,
Nguyên Trang hay Hai Trang, and Two Pages, những tỷ lệ này là những tỷ lệ tương đối so với kích
cỡ của cửa sổ.

Bạn có thể thấy các lựa chọn Phóng to - Thu nhỏ và các phím tắt trong trình đơn "Xem", và bạn cũng
có thể phóng to thu nhỏ bằng cách văn chuột giữa lên hoặc xuống trong khi nhấn giữ phím Ctrl (Mac:
Cmd).

Cách hiển thị khác của bản nhạc

Có thể bạn sẽ muốn xem các tài liệu theo kiểu nằm ngang theo nhau

hoặc dọc theo nhau
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Bạn có thể kéo thanh chắn tách biệt giữa hai bản nhạc để điều chỉnh không gian cửa sổ dành cho
từng cái.

Chế độ Toàn-màn-hình

Chế độ "Toàn màn hình" sẽ mở rộng không gian MuseScore lấp đầy màn hình, cho bạn khung nhìn
rộng hơn.
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Bộ điều hướng

Nếu bạn có một bản nhạc dài và muốn xem mình đang ở vị trí nào hoặc muốn nhảy tới một trang nào
đó, hãy sử dụng cửa sổ Bộ điều hướng nằm dưới cuối màn hình.

Khung chữ nhật xanh lam thì tương ứng với khu vực mà bản nhạc được nhìn thấy trong cửa sổ
chính. Bạn có thể kéo khung này hoặc thanh cuộn, hay nhấp chuột vào một vùng nào đó, ngay lập
tức nó sẽ nhảy đến đó.

Để ẩn/hiện cửa sổ điều hướng này, đi tới trình đơn Xem và chọn Bộ điều hướng, hoặc sử dụng phím tắt
F12 (Mac: fn+F12).
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Xem thêm

Lưu trữ/Xuất dữ liệu/In ấn
Định dạng tập tin
Sự bố trí và định dạng
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Page view_vi.png
Zoom_vi.png

Do you have an unanswered question? Post it in the forum.

Định dạng tập tin
MuseScore hỗ trợ một dãy rộng các định dạng tập tin khác nhau, những tập tin cho phép bạn chia sẻ
và xuất bản bản nhạc trong định dạng trông tốt nhất mà mình cần.
Bạn có thể nhập dữ liệu từ các tập tin theo Tập tin → Mở... và xuất dữ liệu theo Tập tin → Xuất bản
nhạc....
Ngoài ra có các định dạng chi tiết dưới đây, bạn có thể lưu trữ và chia sẻ bản nhạc của mình trên
trang mạng MuseScore.com vào Tập tin → Lưu trực tuyến.... Xem thêm Chia sẻ bản nhạc trực
tuyến.

Định dạng riêng của MuseScore

Có nhiều định dạng sử dụng bởi hộp thoại Tập tin → Lưu trữ hoặc nút  hay phím tắt (Ctrl+S) và
Tập tin → Lưu trữ với....

Định dạng MuseScore (*.mscz)

MSCZ là định dạng tập tin chuẩn của MuseScore và nên dùng nhất.

Một bản nhạc được lưu trong định dạng này sẽ chiếm rất ít không gian đĩa cứng, nhưng giữ được tất
cả thông tin cần thiết. Định dạng này là phiên bản nén ZIP-compressed của tập tin .mscx, nó cũng
chứa được bất kỳ hình ảnh nào.

Định dạng không nén Uncompressed MuseScore ( *.mscx)

MSCX là một định dạng tập tin không nén của MuseScore.

Một bản nhạc lưu trữ trong định dạng này sẽ duy trì mọi thông tin, ngoại trừ hình ảnh. Nó chỉ nên
dùng khi bạn muốn lưu nội dung dưới dạng có thể sửa được bằng tay (tức là có thể sửa được bằng
một trình soạn thảo văn bản nào đó).

Phiên bản trước của MuseScore sử dụng phần mở rộng tập tin là *.msc. Tuy nhiên, cái này xung đột
với phần mở rộng tập tin của Microsoft Windows và đã bị khóa bởi một số nhà cung cấp email. Vì thế,
nó được thay thế bằng phần mở rộng mới hơn MSCX.

Hai định dạng MSCZ và MSCX của MuseScore 2.0 không thể được đọc bởi MuseScore 1.3 hoặc cũ
hơn, sử dụng →XML hay →MXL đối với việc này.

Lưu ý về phông chữ: MuseScore không nhúng các phông chữ trong tập tin, ngoại trừ FreeSerif,
FreeSerifBold, FreeSerifItalic, FreeSerifBoldItalic và các họ phông FreeSans. Nếu bạn muốn chia sẻ
một tập tin MuseScore với các nhóm khác, hãy chọn các phông chữ này cho chữ viết của mình, hoặc
một phông chữ mà các nhóm khác cũng cài đặt nó. Khi một hệ thống không có các phông được chỉ
định trong tập tin, MuseScore sẽ sử dụng một phông dự trữ - tuy nhiên, điều này có thể khiến bản
nhạc của bạn hiển thị khác đi.

Các tập tin dự phòng MuseScore
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Tập tin dự phòng MuseScore (*.mscz, hoặc *.mscx,)

Các tập tin sao lưu dự phòng được tạo tự động và lưu trong cùng thư mục với tập tin MuseScore
bình thường của bạn. Tập tin dự phòng có thêm một dấu chấm ở đầu tên tập tin (.) và một dấu phẩy
(,) tại cuối (ví dụ nếu tập tin bình thường của bạn là "untitled.mscz", thì tập tin sao lưu dự phòng sẽ
là ".untitled.mscz,").

Bản sao lưu dự phòng sẽ chứa bản lưu trước đó của tập tin MuseScore và có thể sẽ trở nên quan
trọng nếu bản sao bình thường của bạn bị lỗi, hoặc khi bạn cần tìm lại bản sao cũ hơn của bản nhạc.

Để mở tập tin sao lưu dự phòng MuseScore, dấu chấm và dấu phẩy nên được loại bỏ khỏi tên tập tin.
Vì nó được lưu cùng thư mục với tập tin MuseScore bình thường của bạn, nên có lẽ cần tạo cho nó
một cái tên duy nhất (ví dụ đổi ".untitled.mscz," thành "untitled-backup1.mscz").

Để nhìn thấy tập tin dự phòng MuseScore, bạn cần thay đổi thiết lập hệ thống thành "Show hidden
files" (hiện các tập tin ẩn) . Xem thêm Cách lấy lại bản sao lưu dự phòng của bản nhạc (MuseScore
2.x).

Xem và in ấn (dùng cho xuất dữ liệu)

PDF (*.pdf)

Định dạng văn bản di động (PDF - viết tắt của Portable Document Format) thì lý tưởng cho việc chia
sẻ bản nhạc của bạn với những người khác, những người không cần chỉnh sửa lại nội dung của nó.
Hầu hết mọi người đều có một trình xem PDF trên máy tính, vì thế sẽ không cần cài thêm phần mềm
nào khác để xem nó.

PNG (*.png)

Tập tin Portable Network Graphics (PNG) là một định dạng ảnh bitmap được hỗ trợ rộng rãi bởi các
phần mềm trên Windows, Mac OS, và Linux.

Định dạng ảnh này thì đặc biệt phổ biến trên trang mạng. Bản nhạc có nhiều trang sẽ xuất ra một tập
tin PNG cho từng trang. MuseScore sẽ tạo các ảnh y như chúng xuất hiện trên giấy in. Trong thẻ xuất
dữ liệu Điều chỉnh → Thiết lập... (Mac: MuseScore → Thiết lập...), bạn có thể thiết lập độ phân
giải và muốn dùng nền trong suốt hay không.
Nếu muốn tạo các ảnh chỉ chứa một phần của bản nhạc, có hoặc không có các biểu tượng trong màn
ảnh, ví dụ các khung chèn, các nốt ẩn, và màu các nốt nằm ngoài âm vực cho phép, hãy xem chụp
hình ảnh

SVG (*.svg)

Tập tin Scalable Vector Graphics (SVG) có thể được mở bởi hầu hết các trình duyệt trang mạng
(ngoại trừ Internet Explorer trước phiên bản 9) và các phần mềm đồ họa vec-tơ. Tuy nhiên, hầu hết
các phần mềm SVG không hỗ trợ phông chữ được nhúng, vì thế các phông MuseScore thích hợp
phải được cài đặt để hiển thị các tập tin này cách chính xác.

Tập tin để nghe (dùng cho xuất dữ liệu)

WAV audio (*.wav)

WAV (Waveform Audio Format) là một định dạng âm thanh không nén.

Tập tin được phát triển bởi Microsoft và IBM, nó được hỗ trợ bởi các phần mềm trên Windows, Mac
OS, và Linux. Nó là một định dạng lý tượng để sử dụng khi tạo các CD với chất lượng âm thanh đầy
đủ được duy trì. Tuy nhiên, dung lượng tập tin lớn khiến nó khó chia sẽ qua email hoặc các trang
mạng.

FLAC audio (*.flac)

Free Lossless Audio Codec (FLAC) là định dạng âm thanh nén.

Tập tin FLAC được ước lượng bằng nửa dung lượng tập tin âm thanh không nén và chất lượng thì
tốt. Windows và Mac OS không hỗ trợ sẵn cho FLAC, nhưng phần mềm như VLC media player có thể
chơi tập tin FLAC trên bất kỳ hệ điều hành nào.
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Ogg Vorbis (*.ogg)

Ogg Vorbis được xem như một sự thay thế định dạng âm thanh phổ biến MP3 miễn phí về bản
quyền.

Giống như MP3, tập tin Ogg Vorbis thì tương đối nhỏ (thường là 1/10 so với âm thanh không nén),
nhưng chất lượng âm thanh bị mất. Windows và Mac OS không hỗ trợ sẵn cho Ogg Vorbis. Tuy
nhiên, VLC media player và Firefox có thể chơi tập tin Ogg trên mọi hệ điều hành.

MP3 (*.mp3)

Tập tin MP3 thì tương đối nhỏ (thường là 1/10 so với tập tin âm thanh không nén), những chất lượng
âm thanh bị mất.

Để có thể tạo tập tin MP3, cần một thư viện ngoài, lame_enc.dll (Windows) hoặc libmp3lame.dylib
(Mac), được cài đặt. MuseScore sẽ hỏi bạn vị trí của nó. Bạn có thể tải nó về tại
http://lame.buanzo.org/.

Vài người dùng mày Mac có thể thấy MuseScore đụng phải một lỗi khi nạp thư viện MP3.Vấn đề có
thể là do thư viện đó là một thư viện 32 -bit. Thư viện 64-bit sẽ làm việc với MuseScore thì có sẵn tại
http://www.thalictrum.com/en/products/lame.html (chú ý nó cần được đổi tên thành libmp3lame.dylib
để MuseScore nhận ra).

Chia sẻ với phần mềm âm nhạc khác

MusicXML (*.xml)

MusicXML là một chuẩn thế giới cho việc lưu thông tin của một bản nhạc.

Đây là một định dạng nên dùng để chia sẽ bản nhạc giữa các trình soạn nhạc khác nhau, bao gồm
Sibelius, Finale, và hơn 100 phần mềm khác.

Compressed MusicXML (*.mxl)

Compressed MusicXML tạo ra tập tin nhỏ hơn so với tập tin MusicXML chính quy.

Đây là một chuẩn mới hơn và không được hỗ trợ rộng rãi bởi các trình soạn nhạc khác tại thời điểm
này.

MIDI (*.mid, *.midi, *.kar)

Musical Instrument Digital Interface (MIDI) là định dạng được hỗ trợ rộng rãi bởi sequencers và các
phần mềm ký âm âm nhạc.

Tập tin MIDI được thiết kế cho việc phát nhạc và không chứa các thông tin bố trí bản nhạc như định
dạng, cao độ, giọng, dấu hoa mỹ, dấu diễn đạt, dấu lặp, hoặc khóa nhạc, và các thứ khác. Để chia sẻ
tập tin giữa các phần mềm ký âm âm nhạc, MusicXML thì nên dùng. Nếu bạn chỉ thích phát lại các
bản nhạc, thì dùng MIDI.

MuseData (*.md) (dùng cho nhập dữ liệu)

MuseData là định dạng được phát triển bởi Walter B. Hewlett đầu năm 1983 như một phương tiện
đầu tiên chia sẻ ký âm âm nhạc giữa các phần mềm.

Nó đã bị lu mờ bởi MusicXML, nhưng hàng ngàn bản nhạc trong định dạng này thì vẫn có sẵn trên
mạng.

Capella (*.cap, *.capx) (dùng cho nhập dữ liệu)

Tập tin CAP và CAPX thì được tạo bởi trình soạn thảo bản nhạc "Capella".

MuseScore nhập dữ liệu khá chính xác từ phiên bản 2000 (3.0) hoặc cao hơn của Capella (2.x thì
không làm việc, định dạng *.all từ phiên bản 1.x thì hoàn toàn không hỗ trợ).
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Bagpipe Music Writer (*.bww) (dùng cho nhập dữ liệu)

Tập tin BWW được tạo bởi trình soạn thảo nhạc niche, "Bagpipe Music Writer".

BB (*.mgu, *.sgu) (dùng cho nhập dữ liệu)

Tập tin BB được tạo bởi phần mềm hòa nhạc, "Band-in-a-Box".

Hiện tại MuseScore đang thử nghiệm hỗ trợ cho tập tin này.

Overture (*.ove) (dùng cho nhập dữ liệu)

Tập tin OVE được tạo bởi trình soạn thảo nhạc "Overture".

Định dạng này chủ yếu phổ biến trong môi trường ngôn ngữ Trung Quốc, như Lục địa Trung Quốc,
Hong Kong, và Taiwan.

Hiện tại MuseScore đang thử nghiệm hỗ trợ cho tập tin này.

Guitar Pro (*.GTP, *.GP3, *.GP4, *.GP5, *.GPX) (dùng cho nhập dữ liệu)

Xem thêm

Lưu trữ/Xuất dữ liệu/In ấn

Do you have an unanswered question? Post it in the forum.

Chia sẻ bản nhạc trực tuyến
Đi tới trang musescore.com/sheetmusic để xem những bản nhạc của người khác từ MuseScore.

Bạn có thể lưu và chia sẽ các bản nhạc của bạn trực tuyến tại MuseScore.com. Bạn có thể chọn lưu
trữ bản nhạc một cách cá nhân đối với những ai muốn truy xuất bản nhạc của bạn từ bất kỳ máy tính
nào, hoặc chia sẽ nó cách công khai. MuseScore.com có thể hiển thị và phát bản nhạc trong trình
duyệt mạng của bạn - một tính nặng phụ thêm để đặt tựa đề VideoScores cho phép đồng bộ hóa giữa
bản nhạc và một vi-deo YouTube. Để sử dụng bên ngoài trình duyệt mạng, bạn có thể tải bản nhạc về
trong nhiều định dạng khác nhau (gồm có PDF, MIDI, MP3, MusicXML, và tập tin gốc MuseScore).

Tạo tài khoản

1. Tới trang MuseScore.com và nhấp vào tạo tài khoản "Create new account". Nhập một username
(Tên đăng nhập) và một email tồn tại và nhấn "Create New Account".

2. Chờ vài phút đợi email từ hỗ trợ của MuseScore.com. Nếu không có email nào được chuyển
tới, kiểm tra thư mục spam (thư rác) trong hộp mail của bạn.

3. Nhấp vào liên kết trong email và đi tới lược sử của tôi user profile để thay đổi password (mật
khẩu).

Chia sẻ bản nhạc trực tiếp từ phần mềm MuseScore

Có thể lưu trực tiếp bản nhạc trực tuyến từ trình đơn Tập tin → Lưu trực tuyến....
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Nếu bạn chưa có tài khoản MuseScore, hãy tạo một cái bằng cách nhấp vào liên kết "Tạo tài khoản".
Nó sẽ mở trình duyệt mạng của bạn và đưa bạn tới trang https://musescore.com/user/register

Tiếp theo, nhập địa chỉ email (thư điện tử) hoặc username (tên đăng nhập), và password (mật khẩu)
trong MuseScore . Khi đăng nhập thành công, bạn sẽ có thể nhập thông tin bản nhạc của bạn.

1. Mục Tựa đề là tựa đề của bản nhạc.
2. Mục Miêu tả nằm ngay dưới nó.
3. Mục "Đặt bản nhạc ở trạng thái riêng tư" nếu không đánh dấu sẽ là Công khai (tức là ai cũng

được xem), hoặc được đánh dấu thì sẽ là Riêng tư (tức là chỉ bạn được xem) - tuy nhiên liên
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kết bí mật có thể được sinh ra.
4. Chọn một giấy phép. Bằng cách dùng một Giấy phép bản quyền sáng tác, bạn sẽ cho phép mọi

người sử dụng bản nhạc của bạn trong giới hạn cho phép.
5. Bạn có thể thêm vào các thẻ chữ để giúp nhận biết các bản nhạc trên MuseScore.com - chúng

được tách nhau bằng dấu phẩy.
6. Trong trường hợp bạn đã lưu bản nhạc này trực tuyến trước đó rồi, nó sẽ tự động cập nhật tới

bản nhạc đó. Nếu muốn lưu nó trực tuyến như một bản nhạc mới thì bỏ chọn mục Cập nhật tới
bản nhạc hiện đã có.

Tải bản nhạc lên trang MuseScore.com

Có thể tải bản nhạc trực tiếp lên trang MuseScore.com như sau:

1. Nhấp vào Liên kết Upload (Tải lên) để tải lên MuseScore.com.
2. Bạn sẽ có các lựa chọn giống trong trình đơn "Lưu trực tuyến" trên phần mềm.
3. Bạn cũng sẽ có thể truy xuất nhiều thông tin hơn, ví dụ như Genre (thể loại).

Chú ý: Bạn chỉ có thể tải lên một lúc 5 bản nhạc, sau đó bạn vẫn có thể tiếp tục tải lên bản nhạc trực
tiếp từ phần mềm MuseScore, nhưng chỉ thấy được 5 cái cuối. Nếu bạn muốn số lượng nhiều hơn,
hãy nâng cấp thành tài khoản Pro Account.

Điều chỉnh bản nhạc trên trang MuseScore.com

Nếu muốn thay đổi bản nhạc của bạn trên trang MuseScore.com, hãy chỉnh sửa tập tin MuseScore
trên máy tính của bạn trước đã rồi theo các bước bên dưới.

1. Đi tới trang nhạc MuseScore.com.
2. Nhấp vào liên kết edit (chỉnh sửa).
3. Trong biểu mẫu, bạn có thể thay đổi tập tin bản nhạc, thông tin và các đặc quyền.

Xem thêm

Cách xóa bản nhạc đã lưu trên trang MuseScore.com

save-online-update_vi.png
window_save_online_score_information_vi.png
window-save-online_vi.png
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Do you have an unanswered question? Post it in the forum.

Ký âm
Trong chương "Các thao tác cơ bản" bạn đã học cách nhập nốt và tương tác với bảng công cụ.
Chương "Ký âm" mô tả chi tiết hơn về các kiểu ký âm khác nhau, bao gồm cả các ký hiệu âm nhạc
nâng cao.

Xem thêm "Các mục nâng cao"

Dấu hóa bất thường
Dấu hóa bất thường có thể được thiết-lập/thay-đổi bằng cách kéo một dấu hóa bất thường từ bảng
công cụ Dấu-hóa-bất-thường tới một nốt nhạc trong bản nhạc.

Nếu muốn thay đổi cao độ của nốt, bạn có thể chọn nốt và nhấn:

↑: Tăng cao độ của nốt lên nửa cung (các dấu thăng hay dùng).
↓: Giảm cao độ của nốt xuống nửa cung (các dấu giáng hay dùng).
Ctrl+↑ (Mac: Cmd+↑): Tăng cao độ của nốt lên một ốc-ta hay quãng tám.
Ctrl+↓ (Mac: Cmd+↓): Giảm cao độ của nốt xuống một ốc-ta hay quãng tám.
J: Thay đổi cách viết trùng âm của một nốt.

Để đưa một dấu hóa bất thường thành dạng dấu hóa báo trước (nghĩa là dấu hóa để trong ngoặc
đơn), bạn hãy kéo dấu ngoặc đơn từ bảng công cụ dấu hóa bất thường lên trên dấu hóa mà bạn
muốn (không phải lên trên đầu nốt nha). Để bỏ dấu ngoặc đơn này đi, hãy chọn dấu hóa đó và nhấn
Del.

Nếu sau đó bạn thay đổi cao độ bằng các phím mũi tên, các thiết lập bằng tay này trên dấu hóa bất
thường sẽ bị loại bỏ.

Xác định lại cao độ

Chức năng trong trình đơn Nốt → Xác định lại cao độ sẽ cố gắng chỉnh lại cho đúng cách ghi các
dấu hóa bất thường cho toàn bộ bản nhạc.

Xem thêm

Hóa biểu: Thay đổi

Liên kết bên ngoài

Dấu hóa trên trang Wikipedia

Do you have an unanswered question? Post it in the forum.

Dấu rải gam và vuốt phím
Arpeggios are set by dragging an arpeggio symbol from the Arpeggio & Glissando palette to a note of
a chord.
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To change the length of the arpeggio, double-click the arpeggio and drag the handle up, or down.

Glissandi are set by dragging a glissando symbol from the Arpeggio & Glissando palette to the first of
two consecutive notes on the same staff.

Edit, or delete the text of a glissando by right-clicking it and select "Glissando Properties" in menu or in
the Inspector. If there isn't enough room between two notes, MuseScore will not display the text.

External links

Arpeggio on Wikipedia
Glissando on Wikipedia

Do you have an unanswered question? Post it in the forum.

Vạch nhịp

Change bar line type

Bar lines are changed by dragging a bar line symbol from the bar line palette to a bar line in the score.

To hide a bar line entirely, select the line and untick Visible in the Inspector (F8).

Create grand staff (great stave)

To extend bar lines over multiple staves, double-click on a bar line (see Edit mode).
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Click and drag the blue handle down to the next staff.

The staff bar line updates appear after leaving edit mode.

See also

Measure operations

Do you have an unanswered question? Post it in the forum.

Dấu nối-cờ-nốt
Beams are set automatically, but they can be altered manually. Drag a beam symbol from the "Beam
Properties" palette to a note in order to change its behavior.

Alternatively, you can first select a note, and then double-click the appropriate symbol in the palette.

 Start a beam at this note.

 Do not end a beam at this note.

 Do not beam this note.

 Start a second level beam at this note.

 Start a third level beam at this note.

 (back to) Automatic mode: the mode MuseScore chooses on note input, dependent on
current time signature.

 Start feathered beam (slower) at this note.
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 Start feathered beam (faster) at this note.

To change the beam angle, or the distance of the beam to the notes (i.e. the length of the stems),
double-click on the beam to put it into edit mode, with the right end handle being selected. Up/down
arrow will now change the angle. Selecting the left end handle and using the up/down arrow keys will
lengthen/shorten the stems. Hit Esc to get out of edit mode, once done with the changes.

To move a beam from above to below the notes, or vice-versa, flip the direction of the stems by using
the button along the second top row (before the voice indicators) that shows a note with stems
attached above and below or use the X key.

See also

Cross staff beaming
Edit mode
Note input
How to add a beam over a rest
How to place a beam between notes

Do you have an unanswered question? Post it in the forum.

Ngoặc nối khuông

Delete

Select the bracket and press Del

Add

Drag a bracket symbol from the bracket palette to an empty space in the first measure of a system.

Change

Drag a bracket symbol from the bracket palette to a bracket in the score.

Edit

Double-click on a bracket to enter edit mode. In edit mode, you can drag the height of a bracket to
span arbitrary staves of a system.

Horizontal offset

If you need to move a bracket further left or right, then double-click the bracket to enter edit mode,
and press Shift+← or Shift+→.

Do you have an unanswered question? Post it in the forum.

Dấu lấy/ngắt hơi
To place a breath symbol, drag it from the breath palette (from the Advanced workspace) to a note in
the score. The breath symbol is placed after the note.

Breath symbol in score:
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Caesura (informally called tram lines or railroad tracks) work the same way.

Do you have an unanswered question? Post it in the forum.

Khóa nhạc
Clefs are created or changed by dragging a clef symbol from the Clefs palette into a measure or onto
another clef. Use F9 (Mac: ⌥+⌘+K) to show or hide the palette window.

Note: Some clefs are only available from the master palette.

Add

Drag a clef from the palette into an empty part of a measure - this creates a clef at the beginning of the
measure.

Drag a clef onto a particular note to create a mid-measure clef - if the measure is not the first in the
staff, it is drawn smaller. An example is a piano score, in which the top staff starts with a G clef and
switches immediately to an F clef, then after a note and a rest, back to a G clef.

Note: a clef dragged onto a note (and especially onto the first note), will not be affected by 'Courtesy
clef' properties.
To see whether the change will apply to the note or the measure, check what changes color when you
drag it.
You can also select the note, or measure first, and double-click the clef on the palette to make sure it
affects the right one.

Remove

Select a clef and press Del.
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Notes:

Changing a clef does not change the pitch of any note. Instead, the notes move to preserve
pitch.
Special/rarely used clefs are not shown in the palette by default. These can be found in the
aforementioned master palette instead.

Do you have an unanswered question? Post it in the forum.

Ký âm cho trống

This translation is outdated, see the English version for a reference: Drum notation

Example drum notation:

Notation for drumsets often includes simultaneous upstem and downstem notes. If you are unfamiliar
with editing multiple voices in a single staff, see Voices for an overview. See below for instructions
specific to percussion notation.

MIDI Keyboard

The easiest way to add drum notation to your score is via MIDI keyboard. Some MIDI keyboards have
percussion markings above each key. If you press the key for high hat, then MuseScore will add the
correct notation to the score. MuseScore automatically takes care of the stem direction and type of
note head.

Computer Keyboard

7 drum sounds are mapped to a shortcut (A-G) by default and you can only remap those 7 shortcuts to
other drum-instruments (or change other properties of the drum palettes contents) via the Edit
Drumset button of the drum input tool (see →below).
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If you wish to enter a new drum note at the same position as an existing note - for example if you
wanted the snare and hi-hat to sound simultaneously - and you were entering the new note via the
computer keyboard you would need to hold Shift when entering the new note so as not to overwrite
the existing note. This is the same method as used when entering chords for tuned instruments under
MuseScore.

Mouse

Note input for unpitched percussion works differently than for other instruments, so here are the
special steps:

1. Select a note or rest in the percussion staff
2. Press N to begin note input

Please note that the drum input tool will only appear when you have completed this step:

3. Select a note duration from the note input toolbar
4. Select a type of note (such as bass drum, or snare) from the drum input tool
5. Click on the percussion staff to add the note to the score

Drumset

Drumsets are stored as .drm files, but customizations can be saved and loaded into others.

External links

Video tutorial: MuseScore in Minutes: Lesson 7 - Tablature and Drum Notation
Drum Parts [video]
Editing the Drum Palette in MuseScore 1.1 [video]
Saving Drumset Changes in MuseScore 1.1 [video]
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Guide to Drum and Percussion Notation

Do you have an unanswered question? Post it in the forum.

Nốt láy
Short grace notes (Acciaccatura) appear as small notes with a stroke through the stem. Long grace
notes (Appoggiatura) have no stroke. Both are placed before the normal-sized main note.

Instructions

Create a grace note by dragging a grace note symbol from the Grace Notes palette to a regular note
on the score. It's also possible to create a grace note by selecting a note head and double-clicking a
grace note symbol from the grace notes palette.

To add more than one grace note, drag successive grace notes on the note head.

To add a chord of grace notes, enter the first one and select it, then use Shift+ note names (C, D, E
etc...)

If you want to change the duration of a previously created grace note, select it and choose a duration
from the toolbar or enter with one of the keys 1 ... 9 (see Note input).

Grace notes after a note (such as a trill termination) may have to be manually adjusted with Ctrl +
arrow keys.

External links

Grace note at Wikipedia
Appoggiatura at Wikipedia
Acciaccatura at Wikipedia

Do you have an unanswered question? Post it in the forum.

Dấu biến cường
Hairpins are line objects. To create a hairpin, select a note to mark the start point.

<: Creates a crescendo hairpin
>: Creates a diminuendo hairpin (decrescendo)

You can also create hairpins by dragging a hairpin symbol from the line palette to a note head.

1. < creates a crescendo hairpin:

2. Double click switches to edit mode.
Then select (click on) the end point to move:
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3. Shift+→ moves the anchor of the selected end point:

4. → and Ctrl→ move the selected end point:

Do you have an unanswered question? Post it in the forum.

Hóa biểu
Key signatures can be created or changed by dragging one from the Key Signatures palette to a
measure, or onto an existing signature.

F9 (Mac: fn+F9) toggles the palette window.

Replace an existing key signature

Drag a key signature from the palette directly onto a key signature in the score. If you want to change
the key signature to only one staff of your score (which might be done in some contemporary music,
for example), press Ctrl (Mac: ⌘) while dragging the key to the right staff.

Add a new key signature

Drag a key signature from the palette onto an empty part of a measure. This will place the key
signature at the beginning of the measure. If you want to add the key signature to only one staff of
your score (which might be done in some contemporary music, for example), press Ctrl (Mac: ⌘)
while dragging the key to the right staff.

Remove a key signature

Click on an existing key signature and press Del, or drag the empty key signature from the palette (in
the advanced workspace) onto the measure.

Courtesy key signature

In the Inspector for a selected key signature, there is an option for "Show courtesy." Additionally, Style
→ General... → Page has on option for "Create courtesy key signatures". The Inspector will affect only
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the selected one; the style setting will affect the entire score.

Naturals on key signature changes

You can choose whether to show natural(s) in certain cases when changing the key signatire. Under
Style → General... → Accidentals you'll see the options:

NOT FOUND: Key_signature-Naturals_en.png

You can Apply the changes, or click OK. If you are in a linked part, rather than in the primary score,
you can apply the change to all parts with the corresponding button.

In this example, the key signature change is showing naturals.

]

Key signature and multimeasure rest

Multimeasure rests are interrupted, if there is change in the key signature.

See Multimeasure rest

Courtesy key signature and section break

A courtesy key signature will not be shown just before a section break
See Break or spacer: Section break

Custom key signatures

Press Shift+K to bring up the master key signature palette.
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You can even use half-flats, half-sharps, etc.

Note, however, that currently the playback of custom key signatures is not supported.

Do you have an unanswered question? Post it in the forum.

Đường kẻ hay nét vẽ
The Lines palette, like other palettes, works via "drag-and-drop". Use the mouse to drag an item from
the palette and drop it onto the score.
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Change length

If you change the length of a line using the mouse, the anchor positions (the notes or measures they
apply to) do not change. Therefore, the following method is recommended for adjusting the start or
end points of a line.

1. If you are in Note Input mode then press Esc to leave note input
2. Double click the line that you want to change
3. Move the handles using the following shortcuts

Shift+→ to move the anchor right by one note (or measure)
Shift+← to move the anchor left by one note (or measure)

4. If you need to change the length visually without changing the notes or measures that the line is
anchored to then use the following shortcuts:

→ to move the handle right by one unit
← to move the anchor left by one unit

See also

Hairpin
Volta (1st and 2nd endings)
Early music feature (ambitus section)

Do you have an unanswered question? Post it in the forum.

Dấu lặng trong ô nhịp

Full measure rest

When an entire measure is devoid of notes, a full measure (full bar) rest is used.
A full measure rest looks like a whole note (semi-breve) rest, except it is centered in the middle of a
measure

To create a full measure rest, select a measure and press Del. All notes and rests in this measure are
then replaced by a full measure rest.
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Multi-measure rest

Multi-measure (multi-bar) rests indicate a long duration of silence for an instrument and are frequently
used in ensemble sheet music. They are automatically interrupted at important points, such as double
bar lines, rehearsal marks, key- or time signatures, etc.
Multi-measure rests have a number above the staff indicating the duration of the rest by the number of
measures

Instructions

1. From the menu, choose Style → General...
2. Click on the "Score" tab, if it is not already selected
3. Add a check mark next to "Create multi-measure rests"

Limitations

The style option automatically creates multi-measure rests throughout the score. Therefore, it is
recommended that you enter all your notes first and then turn on multi-measure rests afterward.

Break multimeasure rest

See also: Measure operation: Break multi-measure rest

You may want to have a multi-measure rest divided into two multi-measure rests.

This option should be checked before turning on the "Create multi-measure rests" option in Style →
General..., in the "Score" tab.
Select the first measure where you want the second multi-measure rest to start, and do a right-click
Measure Properties → Break multi-measure rest.

Note that multi-measure rests are interrupted if there is a rehearsal mark (not a simple text), section
break, key or time signature change, or double bar line.

Do you have an unanswered question? Post it in the forum.

Dấu lặp
The start and end of simple repeats can be defined by setting appropriate bar lines. For instructions on
first and second ending measures, see Volta.

Playback

To hear repeats during playback, make sure the "Play Repeats"  button on the toolbar is
selected. Likewise, you can turn off repeats during playback by deselecting the button.

In the last measure of a repeat, you can set the property "Repeat count" to define the number of
played repeats.

Repeat symbols and text

Text and symbols related to repeats are located in the Repeats palette.
The repeats palette contains the symbols for measure repeat, segno and coda. It also contains 'D.S.',
'D.C.', and Fine text:
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To add an object from the repeats palette, drag it onto (not above) the desired measure (so the
measure changes color), then drop. The object will then appear above that measure in your score.

Jumps

Jumps generally consist of three parts:

Jump to tag
Play up to tag
Continue at tag

Tags are names you give to certain measure positions. Two tags ("start", "end") denote the start and
end of the score and don't need to get added explicitly.

Examples:

At the jump instruction Da Capo the playback jumps to the start and plays the entire score again (up
to the implicit end tag).

At the jump instruction Da Capo al Fine the playback jumps to the start and plays the score up to the
tag Fine.

Dal Segno al Fine (or D.S. al Fine) jumps to the Segno tag and then plays up to the tag Fine

Dal Segno al Coda jumps to the Segno tag and then plays up the first Coda tag. Playback then
continues at the second Coda tag. The properties of jumps can get set via a right-click at the D.S. al
Coda tag.

See also

Volta
How to separate a coda from the rest of the score

External links

Video tutorial: Codas

Do you have an unanswered question? Post it in the forum.

Dấu luyến
A slur is a curved line between two or more notes that indicates they are to be played without
separation. If you mean to join two notes of the same pitch, see Tie

First Method

1. Leave Note input mode and select the first note:
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2. S creates a slur:

3. Shift+Right moves the slur end to the next note:

4. X flips the slur direction:

5. Esc ends Slur Edit mode:

Second Method

1. Leave Note input mode and select the first note
2. Ctrl-select (⌘-select on a Mac) or Shift-select the last note
3. Hit S

Third Method

1. While in Note input mode, key in the first note in the slurred section
2. Hit S to begin the slurred section
3. Key in the remaining notes in the slurred section
4. Hit S to end the slurred section

Adjustments

The handles (displayed in the images for steps 2-4 above) can be adjusted with the mouse. The two
outer ones adjust the start and end of the slur, whilst the two inner handles adjust the contour.

A slur can span several systems and pages. The start and end of a slur is anchored to a note/chord or
rest. If the notes are repositioned due to changes in the layout, stretch or style, the slur also moves
and adjusts in size.

This example shows a slur spanning from the bass to the treble clef. Using the mouse, select the first
note of the slur, hold down Ctrl (resp. ⌘ on a Mac) and select the last note for the slur, and press S to
add the slur.

Dotted line
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Dotted slurs are sometimes used in songs where the presence of a slur varies between stanzas.
Dotted slurs are also used to indicate an editor's suggestion (as opposed to the composer's original
markings). To change an existing slur into a dotted or dashed slur, select it and then in Inspector (F8)
change Line type from Continuous to Dotted or Dashed.

X flips the direction of a selected slur.

See also

Tie
Edit mode
Note input

Do you have an unanswered question? Post it in the forum.

Dấu nối
A tie is a curved line between two notes of the same pitch. If you want a curved line that spans
multiple pitches, see Slur.

First method

Select first note:

+ creates a tie:

(+ or the tie button, , located on the top to the right of the notes in the note input toolbar)

Second method

To create ties during note input, press + after the first note of the tie.

Tied chords

To add ties between two chords, select the stem of the first chord, or Shift + click on the first chord
and press +. Note input mode must not be enabled.

X flips the direction of a selected tie.

Do you have an unanswered question? Post it in the forum.

Số chỉ nhịp
Time signatures are available in the main palette sidebar. You can drag and drop the time signatures
onto the score (see Palette for general information on working with palettes in MuseScore).
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Create your own Time Signature

If a time signature is needed that is not found in the corresponding workspace palette, open the
Master Palette directly to the Time Signature section (ShiftT) to create your own. You can edit the
numerator and the denominator in the Create Time Signature Panel by pressing the Add button. Once
added, just drag and drop the time signature to the score from the window where you created it. Be
aware that it will not appear in the workspace palette. If you want to add it in the palette, read Custom
Palette.

Change default beaming

To adjust beams from the automatic offering, you can click the notes you want to modify.

For example: by default 5/8 is beamed 3+2. You can click the third and then fourth note to beam it
2+3. Don't forget to do it for the other two subdivisions. To edit the third one drag an icon from 

 to the right note. In this example, the "beam start" icon got dragged to the 9th note
and the Beam 16th sub icon to the 13th note.

Delete a time signature

Time signatures you don't need (any longer) can be removed in the above dialog box via right-click →
"Delete Content".

Edit to additive meters

In most cases, you'll only need to edit the first of the upper numbers. The additional upper numbers
are for additive meters, which contain multiple upper numbers separated by a plus sign.
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Different duration from time signature: Pickup measures (Anacrusis) and Cadenzas

There are occasions when the actual duration of a measure is different from the duration specified by
the time signature. Pickup measures and Cadenzas are a common example. To change the actual
duration of a measure without displaying a different time signature, see Measure operations:
Properties, Measure duration.

Local Time Signatures

Time signatures can be different for different staves. An example here is Bach's 26. Goldberg
Variation:

MuseScore has the concept of a global time signature and an actual (local) time signature. To change
the global time signature drag and drop a palette object to a staff. The global time signature is used to
count beats (as shown in the status line) and is the reference for tempo markings. The global time
signature is the same for all staves and normally identical to the actual time signature.

The actual time signature is set in the time signature property dialog and can deviate from the global
time signature for every staff (left hand 18/16 in the example).

NOT FOUND: Time_Signature_Properties_en.png

The text of the time signature can be set independent of the actual values.

A local time signature is set by dropping a time signature symbol while holding the Ctrl key. The local
time signature is set only for one staff. A global time signature is replicated for all staves.

Time signature changes and Other Objects

72

https://musescore.org/sites/musescore.org/files/gb26-1_0.png


Multimeasure breaks are interrupted when a time signature change occurs.
Also, a section break will prevent a courtesy time signature being shown at the end of the previous
measure.

See also

Measure rest
Break or Spacer

Do you have an unanswered question? Post it in the forum.

Sự chuyển tông hay giọng
Transposition moves a selection of notes higher, or lower on the staff. MuseScore supports several
kinds of transposition.

Chromatic transposition, by key

Chromatic transposition moves notes up or down in semitone increments. From the main menu,
choose Notes → Transpose..., select which key signature to transpose - closest, up or down.

Chromatic transposition, by interval

Chromatic transposition moves notes up or down in semitone increments. From the main menu,
choose Notes → Transpose.... Tick "By Interval", select the interval from the popup menus and
whether to transpose up or down.
You can also transpose a selection of notes using the arrow keys (↑ or ↓).

Diatonic transposition

Diatonic transposition (also known as scalar transposition) moves notes up, or down the current scale
according to the key signature. You can move a single note by dragging it up, or down. You can move
a selection of multiple notes with Ctrl + click and drag.

Transposing instruments

Certain instruments such as B-flat trumpet or alto sax are known as transposing instruments. These
instruments sound lower, or higher than their written pitch. MuseScore has built-in support for
transposing instruments.

The Concert Pitch button and Notes → Concert Pitch from the main menu lets you switch between
concert pitch and transposing pitch. Concert pitch helps composers and arrangers because it displays
every instrument in the same key, so the notes on the staff match their sounding pitches. When
concert pitch is turned off, the notes on some instrument staves may not match their sounding
pitches, but they are ready for an instrumentalist to play from. If you use concert pitch during your
session, remember to turn off concert pitch before printing the parts.

Instrument transpositions are already set up in MuseScore. However, if you want a rare instrument or
transposition that is not available in MuseScore, you may need to edit the instrument transposition
manually. Right-click an empty part of the instrument staff and choose Staff Properties.... At the
bottom of the Staff Properties window, you can select the interval of transposition, any octave shifts,
and whether the interval is "Up" (sounds higher than written) or "Down" (sounds lower than written).

See also

How to transpose

Do you have an unanswered question? Post it in the forum.

Tiếng vê
Tremolo is the rapid repetition of one note, or a rapid alternation between two or more notes. It is
indicated by strokes through the stems of the notes. If the tremolo is between two or more notes, the
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bars are drawn between them. Tremolo symbols are also used to notate drum rolls.

The tremolo palette contains separate symbols for one note tremolos (shown with stems below) and
for two note tremolos (shown with no stem below).

To add tremolo to the stem of a single note, select the note head and double-click the desired symbol
in the tremolo palette.

In a two note tremolo, every note has the value of the whole tremolo duration. To enter a tremolo with
the duration of a half note (minim), enter two normal quarter notes (crotchets), and after applying a
tremolo symbol to the first note, the note values automatically double to half notes.

Do you have an unanswered question? Post it in the forum.

Dấu liên
Tuplets are used to write rhythms beyond the beat divisions usually permitted by the time signature.
For example, triplet eighth notes (quavers) in a 4-4 time signature divide the quarter note (crotchet)
beat into three instead of two.

Instructions

To create a triplet, first select a note on the score that specifies the full duration of the triplet group.
For example, a group of triplet eighth notes (quavers) has a "full duration" of one quarter note
(crotchet).

From the main menu, choose Notes → Tuplets → Triplet. This creates a triplet by dividing the full
duration into three equal parts.

They can be further edited.

Note input mode

Tuplet entry works slightly differently in note input mode than the method outlined above. You must
select the duration first, and enter pitches afterward. Below are step-by-step instructions for making
triplet eighth notes.

1. Switch to note input mode by pressing N
2. Make sure the note input marker is in the place that you want to start the tuplet (use the right

and left arrow keys if necessary)
3. Choose the duration for the whole tuplet group from the note input toolbar. For this example,

click on the quarter note (or press 5 on the keyboard)
4. From the main menu, choose Notes → Tuplets → Triplet, or press Ctrl+3 (Mac: ⌘+3)
5. Notice that an eighth note duration is automatically selected. Click on the staff to add pitches or

enter them via computer or MIDI keyboard
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Properties

To change the display properties of a tuplet, select the tuplet number, or bracket, and use the
Inspector (F8).

If neither the number nor the bracket is shown, select a note from the tuplet, then use the Tuplet
button in Inspector to see the above dialog.

For Direction, choose Auto to place the bracket on the same side of the note heads as the stem, or
beam. Choose Up, or Down to explicitly place the bracket above or below the note heads, respectively,
regardless of the stem, or beam position.

For Number type, choose Number to show an integer, Relation to show a ratio of two integers, or
Nothing to show no number at all.

For Bracket type, choose Automatic to hide the bracket for beamed notes and show the bracket if the
tuplet includes unbeamed notes or rests. Choose Bracket, or Nothing to explicitly show, or hide the
bracket, respectively.

If you move the bracket, or tuplet number, you can see vertical and horizontal offset being updated
(default offsets are 0sp for both).

NOT FOUND: insepector2.png

You can restore default settings with the arrow return button on the right.

NOT FOUND: insepector_restoredafaultsettings.png

Style

Go to Style → General... and select Tuplets. It enables you to change all tuplet properties.
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Two adjustments are possible: Vertical and Horizontal

Vertical adjustment has three options with values in space units and one (un)ticked option
Maximum slope: default value is 0.50; range is from 0.10 to 1.00
Vertical distance from stem (see (2) below): default value is 0.25; range is from -5.00 to
5.00
Vertical distance from note head (see (3) below): default value is 0.50; range is from -5.00
to 5.00
Avoid the staves: by default ticked

Horizontal has four options with values in space units
Distance before the stem of the first note (see (5) below): default value is 0.50; range is
from -5.00 to 5.00
Distance before the head of the first note: default value is 0.00; range is from -5.00 to 5.00
Distance after the stem of the last note (see (6) below): default value is 0.50; range is from
-5.00 to 5.00
Distance after the head of the last note: default value is 0.00; range is from -5.00 to 5.00

See also

How to create triplets and other tuplets

External links
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Tuplet at Wikipedia
How To Create Triplets in MuseScore [video]
The User Guide to Tuplets in MuseScore [video]

Do you have an unanswered question? Post it in the forum.

Các giọng

This translation is outdated, see the English version for a reference: Voices

Voices allow you to have notes on a single staff which start at the same time, yet have different
durations. Voices are sometimes called "layers" in other notation software.

In a polyphonic measure, voice 1 usually takes the up-stem notes and voice 2 takes the down-stem
notes.

When to use voices

If you need stems pointing in opposite directions within a chord, on a single staff.
If you need notes of different durations within a single staff, played simultaneously.

Instructions

Start by entering the top voice (the up-stem notes in the image above). When inputting, some notes
may have down-stems, but these will flip automatically when the second voice is added.

If you are using a keyboard (computer or MIDI) to enter notes, use the ← key to move your cursor
back to the beginning of the staff (or measure). If you are using the mouse to position notes on the
staff, this is not necessary.

Click on the "Voice 2" button  (at the right in the toolbar).

Enter all the bottom voice notes (all the down-stem notes). When finished, it might look something like
this:

Note that you must be in Note input mode to select another voice.

Hidden spacer rests

Only the rests of voices 2, 3, and 4 can be deleted, but those of the main voice (1 - blue) can be
hidden.

To hide a rest, select it and press V or uncheck the "Visible" checkbox in the Inspector, which can be
enabled from the View menu or with the shortcut F8 (Mac: fn+F8). If you have Show Invisible turned
on in the View menu, the rest still shows in gray on your screen. The hidden rest will not appear if you
print, or export as PDF, PNG, SVG, etc.
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Exchange voices of notes

1. Select range of notes
2. Edit → Voices
3. Exchange any two voices

Note: The selection can encompass content of any voice, but only two will be processed at once.

See also

How to merge/combine/implode two staves in one with two voices
How to input multiple notes on a staff with different durations
How to make notes in unison overlapping

External links

Video tutorial: How To Write Two Parts On One Staff: Voices

Do you have an unanswered question? Post it in the forum.

Dấu Volta
Volta brackets, or first and second ending brackets are used to mark different endings for a repeat.

To place a volta bracket on the score, drag-and-drop the item from the Lines palette.

The brackets can span more than one measure. Double-click the volta to enter edit mode, and move
the handles with:

one measure right Shift+→
one measure left Shift+←

These commands move the "logical" start or end of the volta bracket, which determines playback in
MuseScore and layout over multiple systems. Moving the handles using the left or right arrows keys
only, or using the mouse allows finer adjustments, but does not change how the repeat is played.

If you move the handles, a dashed line from the logical position to the actual position is shown

Text

You can change the text and many other properties of a volta bracket using the line properties dialog.
Right-click on a volta bracket and choose Line Properties.... The figure below shows the volta text
as "1.-5."
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You can also right-click on the volta and bring up the volta properties dialog. From here, you can
change both the displayed Volta text (the same from the line properties above) and the repeat list. If
you want one volta to be played only on certain repeats and another volta on other repeats, enter the
repeat times in a comma separated list. In the example below, this volta will be played during repeat
1, 2, 4, 5 and 7. Another volta will have the other ending, like 3, 6 and possibly other higher numbers
like 8, 9, etc.

Playback

Sometimes a repeat plays more than two times. In the figure above, the volta text indicates that it
should play five times before it continues. If you want to change the number of times MuseScore plays
a repeat, go to the measure containing the end repeat bar line and change its Repeat count (see
Measure operations: Other properties for details).
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External links

Video tutorial: Repeats, 1st and 2nd time endings
Screencast: Add alternative repeats with MuseScore

Do you have an unanswered question? Post it in the forum.

Vấn đề âm thanh và phát bản nhạc
MuseScore has "Sound and playback" capabilities built-in. This chapter covers the playback controls
and ways to extend the instrument sounds beyond the built-in piano sound.

Do you have an unanswered question? Post it in the forum.

Chữ viết
The previous chapter covers text that affects playback tempo, but there are many other types of text
available in MuseScore: lyrics, chord symbols, dynamic markings, fingering, figured bass, headings,
rehearsal marks, plus many more. These are all accessible from the main menu via Add → Text.

For short generic text, use staff or system text. The difference between these two texts is whether you
want it to apply to a single staff, or the whole system. This makes a difference when extracting parts.

Do you have an unanswered question? Post it in the forum.

Định dạng
Do you have an unanswered question? Post it in the forum.

Các chủ đề nâng cao
Do you have an unanswered question? Post it in the forum.

Các chức năng mới trong MuseScore 2.0
For an overview of the new features, see What's New in MuseScore 2, Release notes for MuseScore
2.0, Release notes for MuseScore 2.0.1, and Changes in MuseScore 2.0.
Documentation of new features are available in the chapter they belong to logically (except the one
that is referring to upgrading from 1.3 to 2.0) , but for users coming from 1.x here's a collection of links
to be able to see at a glance what can be done now...

See also

Album (→Advanced topics)
View modes: Continuous view and Navigator (→Basics)
Copy and paste: Selection filter (→Basics)
Custom palette (→Advanced topics)
Early music features (→Advanced topics)
Figured bass (→Advanced topics)
Grid-based movement of symbols and staff text (→Text)
Image capture (→Formatting)
Inspector and object properties (→Advanced topics)
Measure operations: Split and join (→Basics)
MIDI import (→Sound and playback)
Mid-staff instrument change (→Sound and playback)
Part extraction (new options available) (→Advanced Topic)
Rehearsal marks: Automatic next rehearsal mark and Search for a rehearsal mark (→Text)
Save/Export (→Basics)
Staff type properties (→Advanced topics)
Swing (→Sound and playback)
Tablature (→Advanced topics)
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Nonexistent node nid: 39841.
(→Advanced topics)
Master palette (→Advanced topics)
Layout and formatting (some options have changed, and there is a new "apply to all parts"
feature) (→Formatting)
Break and spacer: Section break (→Formatting)
Selection modes: Select all similar new options (same subtype) (→Basics)
Create a new score: start center (→Basics)
Languages settings and translation updates (→Basics)
Helping and improve translation (→Support)
Accidentals: Respell pitches (→Notation)
Re-pitch mode (→Advanced topics)
Tools (→Advanced topics)
Meta tags (→Advanced topics)

Do you have an unanswered question? Post it in the forum.

Hỗ trợ
This chapter describes how to find help using MuseScore: the best places to look, the best way to ask
a question on the forums, and tips for reporting a bug.

Do you have an unanswered question? Post it in the forum.

Phụ lục
Do you have an unanswered question? Post it in the forum.
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